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1

1 Introduction

1.1 Add-onModule RF-DYNAM Pro

Whether you are a beginner or already an expert user workingwith one of the previous RF-DYNAM
versions, everybody can quickly learn how to use the new add-on module. All the valuable hints
from our customers telling us about their everyday experience helped us to develop and improve
this add-onmodule. There are many new features available, which improves and enhances the
possibilities of a dynamic analysis.

The RF-DYNAM Pro module is split into four parts: The add-on module RF-DYNAM Pro - Natural
Vibrations is the basic module that performs natural vibration analyses for member, surface and
solid models. A multi-modal and multi-point response spectra analysis and a linear time history
analysis of the given structure can be performedwith themodule RF-DYNAMPro - Forced Vibrations.
A nonlinear time history analysis is available in the add-on module RF-DYNAM Pro - Nonlinear Time
History. The add-on module RF-DYNAM Pro - Equivalent Loads covers the equivalent static force
analysis (based on the multi-modal response spectra analysis) in accordance to various building
standards.

We hope you enjoy working with RF-DYNAM Pro.

Your DLUBAL team

Natural Vibrations
RF-DYNAM Pro - Natural Vibrations determines the lowest eigenvalues of the model. The number
of the eigenvalues can be adjusted. Masses are directly imported from load cases or load combi-
nations (with the option to import the total mass or only the Z-component of loads). Additional
masses can be defined manually at nodes, lines, members or surfaces. Furthermore, you can
influence the stiffness matrix by importing axial forces or stiffness modifications of a load case or
a load combination.

The main features are listed below:

• Automatic consideration of masses from self-weight

• Direct import of masses from load cases or combinations

• Optional definition of additional masses (nodal, line, member, and surface masses as well as
mass moments of inertia)

• Combination of masses in different mass cases and mass combinations

• Pre-set combination factors according to EN 1998-1 CEN

• Masses can be neglected on arbitrary parts of the model

• Optional consideration of normal forces to modify the geometric stiffness matrix

• Stiffness modification (for example, you can import deactivated members or stiffnesses from
RF-CONCRETE)

• Consideration of failed supports or members possible as initial conditions

• Definition of several natural vibration cases possible (for example to analyse different masses
or stiffness modifications)

• Output of eigenvalue, angular frequency, natural frequency and period

• Determination of mode shapes and masses in FE mesh points

• Output of modal masses, effective modal masses, and modal mass factors



1 Introduction

©DLUBAL SOFTWARE 2020

5

1
• Visualization and animation of mode shapes

• Different scaling options for mode shapes

• Documentation of numerical and graphical results in the printout report

Four powerful eigenvalue solvers are available in RF-DYNAM Pro - Natural Vibrations:

• Root of the characteristic polynomial

• Lanczos method

• Subspace iteration

• ICG iteration method (Incomplete Conjugate Gradient)

The selection of the eigenvalue solver primarily depends on the size of the model.

After the calculation, the eigenvalues, natural frequencies and periods are listed. These result
tables are embedded in the main program RFEM. The mode shapes of the structure are tabulated
and can be displayed graphically or as an animation. All result tables and graphics are part of the
RFEM printout report. Moreover, exporting the tables to Excel is possible.

Forced Vibrations
RF-DYNAM Pro - Forced Vibrations is an extension of the add-on module RF-DYNAM Pro - Natural
Vibrations. Mechanical structures that are excited by transient or harmonic force-time or accel-
eration-time diagrams can be analysed using the modal analysis or the linear implicit Newmark
solver. Furthermore, a multi-modal and multi-point response spectra analysis can be performed.
The required spectra can be created according to the standards or individually. The add-on mod-
ule contains an extensive library of accelerograms from earthquake zones. They can be used to
generate response spectra.

The features of the time history analysis are listed below:

• Combination of user-defined time diagrams with load cases or load combinations (nodal,
member and surface loads aswell as free andgenerated loads canbe combinedwith functions
varying over time)

• Combination of several independent excitation functions possible

• Extensive library of earthquake recordings (accelerograms)

• Modal analysis based on the eigenvalue analysis or direct integration with the implicit New-
mark solver in the linear time history analysis available

• Modal analysis:
- Direct import of initial deformations from a load case possible
- Stiffness modifications from NVCs are taken into account

• Implicit Newmark solver:
- Independent of eigenvalue analysis
- The member type Dashpot provides the possiblity to model local linear viscous damping
elements with parallel connected linear spring elements (Kelvin-Voigt-Model).

• Structural damping using the Rayleigh damping coefficients or the Lehr's damping values

• Graphical result display in a time course monitor

• Export of results in user-defined time steps or as an envelope
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The features of the response spectra analysis are listed below:

• Response spectra of numerous standards (EN 1998-1 [1], DIN 4149 [2], IBC 2012 [3] etc.)

• Response spectra can be user-defined or generated from accelerograms

• Direction-relative response spectra approach

• Different response spectra can be assigned to different supports (multi-point option)

• Relevant mode shapes for the response spectra can be selected manually or automatically
(the 5% rule from EN 1998-1 [1] can be applied)

• Calculation is performed within RF-DYNAM Pro and is therefore linear

• Modifications of the stiffness matrix as defined in the Natural Vibration Cases are also used for
the calculation of internal forces and deformations

• Combination of the modal responses (SRSS rule or CQC rule) and combination of the results
from different excitation directions (SRSS or 100% / 30% rule)

The results from the time history analysis are displayed in a time course monitor. Here, you have
the possibility to superimpose different nodes or positions within one member. All results are
displayed as a function of time. The numeric values can be exported to MS Excel. In case of a time
history analysis, you can export results of a single time step or filter the most unfavourable results
of all time steps.

As the response spectra analysis is based on the eigenvalues and mode shapes and the internal
forces, deformation and further results are calculated internally within RF-DYNAM Pro, the calcula-
tion is purely linear, but the stiffness modifications as defined in the Natural Vibration Cases are
used for the whole analysis. Only result combinations are exported. A combination of the modal
responses and a combination of the results due to the components of the earthquake action are
done internally.

The input data of RF-DYNAM Pro and the exported load cases and result combinations are part of
the printout report.

Nonlinear Time History
RF-DYNAM Pro - Nonlinear Time History is an extension of the RF-DYNAM Pro - Forced Vibrations
module. Its GUI is fully integrated in the structure of that add-on module. It is extended by two
nonlinear time history solvers – the nonlinear implicit Newmark solver and the explicit solver.

This add-on module allows for nonlinear dynamic analyses to external excitations, either time
diagrams or accelerograms. Various excitation functions can be defined tabularly as harmonic
loads or as a function of time. An extensive library of accelerograms is available. This module
extension removes the limitation to linear systems in dynamics.

The main features are listed below:

• Combination of user-defined time diagrams with load cases or load combinations (nodal,
member and surface loads aswell as free andgenerated loads canbe combinedwith functions
varying over time)

• Definition of user-defined time diagrams in tabular form, as periodic or as a function term

• Combination of several independent excitation functions possible

• Extensive library of earthquake recordings (accelerograms)

• Nonlinear time history analysis eitherwith the nonlinear implicit Newmark solver or an explicit
solver
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• Supported nonlinearities:
- Types of members (tension, compression members, cables)
-Member nonlinearities (failure, tearing or yielding under tension/compression, plastic hinge)
- Support nonlinearities (failure, friction, diagram, partial activity)
- Hinge nonlinearities (fixed options, friction, diagram, partial activity)
- Nonlinear material models

• The member type Dashpot provides the possibility to model local linear viscous damping
elements with parallel connected spring elements (Kelvin-Voigt-Model).

• Calculation independent of eigenvalue analysis

• Definition of structural damping via the Rayleigh damping coefficients

• Graphical result display in a time course monitor

• Export of results in user-defined time steps or as an envelope

The results from the nonlinear time history analysis are displayed in a time course monitor. All
results are displayed as a function of time. Results of single time steps or dynamic envelopes of all
time steps are available. All results can be exported to MS Excel.

The input data of RF-DYNAM Pro and the exported load cases and result combinations are part of
the printout report.

Equivalent Loads
RF-DYNAMPro - Equivalent Loads is an extension of the RF-DYNAMPro - Natural Vibrations add-on
module. With this module, seismic analyses can be performed with the multi-modal response
spectrum analysis. The required spectra can be created according to the standards or user-defined,
from which the equivalent static loads are generated.

The main features are listed below:

• Response spectra of numerous standards (EN 1998-1 [1], DIN 4149 [2], IBC 2012 [3] etc.)

• Input of user-defined response spectra

• Direction-relative response spectra approach

• Relevant mode shapes for the response spectra can be selected manually or automatically
(the 5% rule from EN 1998-1 [1] can be applied)

• Generated equivalent static loads are exported to load cases, separately for each mode and
direction

• The calculation of these load cases is performed in RFEM. Thus, a non-linear calculation can
be performed.

• Stiffness modifications that are applied in the Natural Vibration Cases are not automatically
applied in the Load Cases

• Combination of the modal responses (SRSS or CQC rule) and combination of the results from
different excitation directions (SRSS or 100% / 30% rule)

• Results envelopes with maximum andminimum results or signed result in accordance to a
dominant mode shape

Equivalent static loads are generated separately for each relevant eigenvalue and excitation direc-
tion. They are exported to static load cases, and a static analysis is performed in RFEM. Those load
cases are quadratically combined in result combinations, followed by the combination of different
excitation directions.

The input data of RF-DYNAM Pro and the exported load cases and result combinations are part of
the printout report.
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1.2 Using theManual

Topics like installation, graphical user interface, evaluation of results, and printout are described in
detail in the manual of the main program RFEM. This manual, however, focuses on typical features
of the RF-DYNAM Pro add-on module.

The sequence and structure of the manual follows the input and results windows of the module.
In the text, the buttons are given in square brackets, for example [Edit]. At the same time, they
are pictured on the left. The expressions that appear in dialogue boxes, windows, and menus are
set in italics.

At the end of the manual, you find the index. If you do not find what you are looking for, you can
use the search option for our Knowledge Base to find a solution among the articles on dynamics.
The FAQ pages are also highly recommended. Furthermore, you canwatch the recordedWebinars
and study the Verification Examples.

1.3 Opening the RF-DYNAM ProModule

In RFEM, you have the following possibilities to start the add-on module RF-DYNAM Pro.

Menu
To open the add-on module, select

Add-onModules → Dynamic → RF-DYNAM Pro

on the RFEMmenu.

Figure 1.1: Menu Add-onModules→Dynamic→ RF-DYNAM Pro

If RF-DYNAM Pro was opened before and is your current module, you can also select

Add-onModules → Current Module.

www.dlubal.com/en/support-and-learning/support/knowledge-base
www.dlubal.com/en/support-and-learning/support/faq
www.dlubal.com/en/support-and-learning/learning/webinars
www.dlubal.com/en/downloads-and-information/examples-and-tutorials/verification-examples
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Navigator
Alternatively, you can open the add-on module in the Data navigator via

Add-onModules → RF-DYNAM Pro.

When you right-click on the add-on module to open its shortcut menu, you can add RF-DYNAM
Pro to your Favourites (see Figure 1.2).

Figure 1.2: Data navigator Add-onModules→ RF-DYNAM Pro

Panel
If RF-DYNAM Pro results are already available, you can also open the add-on module via the panel.

To display the panel, select the RF-DYNAM Pro case in the drop-downmenu of the main program
RFEM and make the results visible with the [Show Results] button. If the panel is not shown, you
can activate it by clicking the [Panel] button.

Use the [RF-DYNAM Pro] button in the panel to re-open the add-on module.

Figure 1.3: Panel with [RF-DYNAM Pro] button
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2 Input Data
When you start the add-on module, a new window opens. The window is organized in several
tabs and sub-tabs which you should go through from left to right when you enter data for the first
time. Not all tabs are shown right from the beginning, some tabs belong to special settings that
appear as soon as you have selected the corresponding check boxes.

The first window that appears when you open RF-DYNAM Pro is shown in Figure 2.1.

Figure 2.1: Module Window General Data

In theGeneral tab, you decidewhich of the add-onmodules of RF-DYNAMPro youwant to activate.
You can analyse natural frequencies andmode shapes of the structural systemwith RF-DYNAMPro -
Natural Vibrations. With RF-DYNAMPro - Forced Vibrations, you can perform amulti-modal response
spectrum analysis or a linear time history analysis. A time history analysis under consideration of
the defined nonlinearities in your model is possible with RF-DYNAMPro - Nonlinear Time History.
The module RF-DYNAMPro - Equivalent Loads offers you a multi-modal response spectrum analysis
with the export of equivalent static forces.

Add-on modules that were not purchased can be opened, but they run only as a demo version.
You can also activate a 90-day trial version of those add-on modules.

Natural Vibrations
This option is selected by default because a natural vibration analysis of the structure is required
in most cases. The tabsMass Cases and Natural Vibration Cases belong to this option by default.
When you select theMass combination check box, the corresponding tab appears (see Figure 2.1).
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Forced Vibrations
With this module, you can either perform a multi-modal response spectrum analysis or a linear
time history analysis. When you select both (Response spectra and Accelerations), you can generate
response spectra from an acceleration-time diagram. The Response Spectra tab appears when
Response spectra option is selected, the Accelerograms tab appears when Accelerations option is
selected. The TimeDiagrams tab appears when the Time diagrams option is selected. The Dynamic
Load Cases tab is available for all three options of the RF-DYNAM Pro - Forced Vibrationsmodule.

Nonlinear Time History
With this add-on module, a nonlinear linear time history analysis can be performed. The user
interfaces of the linear and the nonlinear time history analyses are identical. The Accelerograms
tab appears when Accelerations option is selected, the Time Diagrams tab appears when Time
diagrams option is selected. The Dynamic Load Cases tab is available in both cases.

Equivalent Loads
This option allows the generation of equivalent static forces in accordance with various design
standards (EN 1998-1 [1], IBC2012 [3] and many others). The Response Spectra and the Dynamic
Load Cases tabs belong to the module RF-DYNAM Pro - Equivalent Loads.

2.1 Structure of Main TabWindow

The module window of RF-DYNAM Pro always contains the following buttons:

The [Help] button gives direct access to the manual and further on-line help. The help system can
also be reached by Help → ... or by pressing the function key [F1].

To change the units or number of decimal places of any input data or results, you have direct
access to the Unit and Decimal Places dialogue box as known from the main program RFEM. It can
also be reached by the Settings → Units and Decimal Placesmenu. This is further discussed in
Section 2.13 and Section 4.7.

In the Details dialogue box you define global settings that apply to whole dynamic calculation
performed in RF-DYNAM Pro. This dialogue box is also accessible by Settings → Details. The
settings are explained in Section 2.12.

To check the input data, click [Check]. This does not perform the calculation and the module
window stays open.

To perform the calculation and exit the RF-DYNAM Promodule, press the [OK & Calculate] button.

To save the input data and exit the RF-DYNAM Pro module, press [OK]. The calculation is not
performed.

To exit the module without saving the new data, click [Cancel].

As shown in Figure 2.1, themain tabs that are available areGeneral,Mass Cases,Mass Combinations,
Natural Vibration Cases, Response Spectra, Accelerograms, Time Diagrams, and Dynamic Load Cases.
Beside the General tab, all main windows are structured in a similar manner. This is explained
using theMass CaseWindow shown Figure 2.2.

On the left hand side of each main window, you have a list of existing cases together with their de-
scriptions. It ismarked by an orange box in Figure 2.2. Those can beMassCases,MassCombinations
or Natural Vibration Cases, for example.

At the bottom of this list, marked with a red box in Figure 2.2, you find several buttons to create
new cases, copy existing cases or delete existing cases.

There are also buttons to select all cases, deselect all cases, and to invert the selection of cases.
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In the right part of the main window, you find the number of the selected case together with the
case description at the top (marked by a blue box in Figure 2.2). In the description box, you can
enter a case descriptionmanually or choose one from the drop-down list. Below you find themain
entering area for your input data which firstly opens in the General sub-tab. Some more sub-tabs
may appear depending on the selected check boxes.

In theGeneral sub-tab, you can enter a comment. This space is marked by a green box in Figure 2.2.

2.2 Mass Cases

In RF-DYNAM Pro you have the possibility to define severalMass Cases. TheMass Casewindow is
shown in Figure 2.2.

Figure 2.2: Module WindowMass Cases with General tab –MC2 is selected and all four options to define
additional masses are selected to show the sub-tabs

The mass case number is set automatically and cannot be edited. If a mass case is deleted later,
the numbers do not change. You can enter a description manually, or you can choose one from
the drop-down list.

2.2.1 Mass Case Type

Choose one of the mass case types from the drop-down list. This is especially important when you
useMass Combinations (see Section 2.3). Combination factors are then pre-set in accordance with
EN 1990 CEN [4] and EN 1998-1 CEN [1].

2.2.2 Masses

Select the From self-weight of structure check box when you want to include the self-weight inde-
pendent of any load case defined in RFEM. This option is shown in Figure 2.2.

You can import masses from a load case or load combination defined in RFEM by selecting the
From force components check box. Choose the relevant Load case or Load combination from the
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lists. Load types like forces and moments will be imported. Additionnally, the types Pipe content -
full and Pipe content - partial can be converted into masses.

The factor to modify loads of load cases, which can be set in the calculation parameters of RFEM
(Edit→ Load Cases and Combinations), is not applied in RF-DYNAM Pro. To increase the masses
by a factor you have to employMass Combinations described in Section 2.3.

When you import a load case that contains self-weight of the model, make sure that the From
self-weight of structure check box in this tab is cleared. Otherwise you will double the self-weight
of the model.

In Section 2.2.4, global settings in RF-DYNAM Pro are described that influence the mass import
from Load Cases.

In addition, or as an alternative to the previously described options to import masses, it is possible
to define nodal, line, member, or surface masses. Depending on the check boxes you select,
additional sub-tabs will appear as shown in Figure 2.2. The settings within those sub-tabs are
detailed in Section 2.2.5 and Section 2.2.6.

2.2.3 Sum of Masses

On the right hand side of the window, the sums of masses are shown to double-check the input of
self-weight, imported masses from load cases or combinations, and additional masses. The total
mass and the resulting centre of mass of the selectedMass Case are indicated as well.

Possibly neglectedmasses (see Section 2.2.4) are not reflected in the sumofmass. Here, full masses
are presented.

2.2.4 Global Settings for Mass Import inDetails

The Details dialogue box controls the global settings which influence the import of masses. In
particular, it is the type of mass conversion and the option to neglect masses. Those settings
are global, i.e. they act on all definedMass Cases in RF-DYNAM Pro. For further details on Details
dialogue box, see Section 2.12.

Mass Conversion Type
You can determine whether Full loads or only Z-components of the forces in both Z-directions or
only in the direction of gravity are imported. The available options are shown in Figure 2.3.

Figure 2.3: SectionMass Conversion Type in Details dialogue box

The third option imports full loads regardless their direction. This is the only way to import masses
from horizontal earth pressure.

When different loads are acting on one FE-node, the load resultant is built first. It is then imported
to RF-DYNAM Pro.

The direction of gravity is defined in the direction of the global Z-axis when the positive orientation
is defined downwards. It is defined against the direction of the global Z-axis when the positive
orientation is defined upwards. The settings shown on the left can be found in the Edit → Model
Data → General Datamenu of RFEM.
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Neglect Masses
It is possible to neglect masses from parts of the model. For this, select the Neglect masses option
as seen in Figure 2.4.

Figure 2.4: Section Neglect Masses in Details dialogue box

With the button, you open the Neglect Masses dialogue box (see Figure 2.5). There you can
define which masses of nodes, members, lines and surfaces are to be neglected.

Figure 2.5: Dialogue box Neglect Masses for masses on nodes, members, lines, and surfaces

You can enter a list of nodes (members, lines and surfaces) manually or pick them graphically by
using the button. The filter button [Select supports only] turns blue when activated; it is useful
for the selection of supports. If this filter is active, you can select the whole model, but only the
supported nodes (members, lines or surfaces) will be selected.

You can decide which directions of masses are to be neglected by selecting the relevant check
boxes for displacements uX, uY and uZ and rotations 𝜑X, 𝜑Y and 𝜑Z.

In the SumofMasses section of theMass Case tab (see Figure 2.2), the neglected masses are not
visible. There always the full masses are shown. The neglected masses on the single FE-nodes can
be checked in the result table 5.6 Masses onMesh Points (see Section 4.1).

You can find an example of the neglecting masses feature in the Knowledge Base - 001222.

www.dlubal.com/en/support-and-learning/support/knowledge-base/001222
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2.2.5 Additional Nodal Masses

The Nodal Masses tab is shown in Figure 2.6. It is available when theManually define additional
masses at nodes option has been selected in the General tab.

Figure 2.6: Module Window Nodal Masses

You can enter a list of nodes manually or use the function to select the relevant nodes in the
work window.

The masses m [kg] can be defined manually. They act in the directions defined in the Natural
Vibration Cases (see Section 2.4.3).

In addition, theMassmoment of inertia IX, IY, and IZ can be defined to model more complex mass
points (i.e. rotation of a machine can approximately be considered).

The buttons beneath the table provide common table functions as described in the RFEMmanual,
Section 11.5.

The table entry can be stored in a library and can be opened whenever needed. The [Save] button
opens a dialogue box where you can enter a file name.
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2.2.6 Additional Line, Member and Surface Masses

In addition to nodal masses, you can define line, member or surface masses manually. The cor-
responding sub-tabs appear when the check boxes for additional masses at Lines, Members or
Surfaces have been selected in theMass Cases tab (see Figure 2.2). The table to enter additional
line masses is shown in Figure 2.7.

Figure 2.7: Module Window LineMasses

As the tables to enter member and surface masses are very similar, they are not explicitly shown
here.

A list of lines (members or surfaces, respectively) can be entered manually or by using the
function which makes it possible to select the objects graphically in the work window.

Line andmember masses are provided in [kg] per unit length. Surface masses are given in [kg] per
unit area. They can be defined manually and act in the directions defined in the Natural Vibration
Cases (see Section 2.4.3).
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2.3 Mass Combinations

Mass cases can be combined tomass combinations. This is done in analogy to load cases and load
combinations in RFEM as described in the RFEMmanual in Section 5.5.1. TheMass Combinations
tab only exists when the corresponding check box has been selected in the General tab (see
Figure 2.1). When you open theMass Combinations tab for the first time, a mass combination is
pre-set and the existing mass cases are listed with the combination factors set by default.

Themodule windowwithmass combinationMCO1 containing self-weight and imposed loadmass
cases is illustrated in Figure 2.8.

Figure 2.8: Module WindowMass Combinationswith all existing mass cases selected for mass combination

You can add selected or all mass cases to a mass combination by using the buttons shown on
the left. By doing so, the mass cases move from the left to the right list. Combination factors are
pre-set automatically by RF-DYNAM Pro, but can be changed manually.

Similarly, you can remove single or all mass cases from a mass combination by using the buttons
shown on the left.

The combination factors are pre-set in accordance to EN 1990 [4] and EN 1998-1 [1]. Those factors
can be adjusted manually by entering a value or choosing a value from the drop-down list. As
regulated in [1] Section 3.2.4, additional masses beside the self-weight have to be considered to
calculate inertia effects.

∑Gk,j “+” ∑ 𝜓E,i ⋅ Qk,i (2.1)

where Gk,j are the permanent loads and Qk,i any imposed load. 𝜓E,i are the combination factors
for the imposed loads defined as

𝜓E,i = 𝜑 ⋅ 𝜓2,i (2.2)

where 𝜓2,i are regulated in EN 1990 Table A.1.1 and 𝜑 are provided in EN 1998-1 Section 4.2.4.

The combination factors may be regulated differently in each National Annex of EN 1998-1 or
other international building standards.
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2.4 Natural Vibration Cases

The Natural Vibration Cases tab is the centrepiece of the RF-DYNAM Pro - Natural Vibrations
module. It is essential for the response spectrum analysis and the time history analysis based on
modal decomposition (modal analysis).

In this tab, you set howmany eigenvalues youwant to calculate, definewhichmasses are used and
in which direction they act. You also set the eigenvalue solver, the type of mass matrix and define
how the mode shapes are scaled. This is also the place where you define stiffness modifications or
import axial forces as an initial condition.

The General tab of the Natural Vibration Casewindow is shown in Figure 2.9.

Figure 2.9: Module Window Natural Vibration Caseswith General tab

For each natural vibration case NVC, you can set various calculation parameters as shown in
Figure 2.10.

The number of the natural vibration case is set automatically and cannot be edited. When a case
is deleted later, the numbers do not change. You can decide whether the specific NVC is to be
calculated or not by selecting or clearing its To Solve check box.

You can calculate eachNVC separately by using the shortcut menu and apply Calculate. The colour
of a NVC is grey when no results of this natural vibration case are available. It turns green as soon
as the calculation is finished and results are available. For more information, see Section 3.3.
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Figure 2.10: Module Window Natural Vibration Caseswith Calculation Parameters tab

2.4.1 Number of Eigenvalues

In the General tab (see Figure 2.9), you define the number of lowest eigenvalues to be calculated.
The maximum number of eigenvalues is limited to 9,999 in RF-DYNAM Pro, but is also limited by
the structural system. The number of available eigenvalues is equal to the degrees of freedom
(number of free mass points multiplied by the number of directions in which the masses are
acting).

It is possible to calculate eigenvalues only above a certain value of natural frequency f to reduce
the number of produced results.

Be careful with this option and study the lowest eigenvalues of the system first. To evaluate the
importance of each eigenvalue, the Effective Modal Mass Factors are useful (see Section 4.1.4).

2.4.2 Scaling of Mode Shapes

The mode shapes can be scaled to any arbitrary value. The first three options are all a good
choice for a satisfying illustration of the mode shapes. The option |uj| = √u2

x + u2
y + u2

z = 1

scales the magnitude of the mode shape vector ui (only translational parts) to 1. The option
Max{uX,uY,uZ} = 1 chooses the maximum translational part of the mode shape vector and sets it
to 1. The optionMax{uX,uY,uZ,𝜑X,𝜑Y,𝜑Z} = 1 considers the complete mode shape vector includ-
ing the rotational parts, chooses the maximum and sets this to 1. For all those three options, the
scaling is done separately for each eigenvalue i.

The option {uj}T[M]{uj} = 1 is always used internally for time history or response spectrum analy-
ses, regardless the choices set here. Themodal massesmj are 1 kg for each eigenvalue when using
this scaling option (see Section 4.1).

No matter which scaling option is chosen: the translational mode shapes uX, uY and uZ are dimen-
sionless and the rotational mode shapes 𝜑X, 𝜑Y and 𝜑Z are provided in [1/m]. The resulting mode
shapes are discussed in Section 4.1.2.
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2.4.3 ActingMasses

For each natural vibration case (NVC), aMass case orMass combination can be imported. Select it
from the respective list in the Calculation Parameters sub-tab (see Figure 2.10).

You have to define the direction in which the masses are acting. The masses act in the global
translational X, Y, or Z-direction when you activate the corresponding check boxes, or rotationally
about the global X, Y, and Z-axes.

Those settings change yourmassmatrix: Youwill get different resultingmode shapes and frequen-
cies. To perform a planar calculation of your structure, consider only masses acting in one global
direction at a time. The planar simplification requires a regular structure. For a three-dimensional
analysis, consider masses acting in all global directions.

2.4.4 Type of Mass Matrix

Five different types of mass matrices are available in the Calculation Parameters tab as shown in
Figure 2.10.

Diagonal matrix

When the type of the mass matrix M is chosen to be diagonal, the masses are lumped to the
FE-nodes. The entries in the matrix are the lumped masses in the translational directions X, Y, and
Z. Masses rotating about the X, Y or Z-axis are considered depending on the type of diagonal
matrix. There are three different types of diagonal mass matrices available:

- Diagonal matrix (translational DOFs)

Only masses in the translational directions X, Y, and Z are considered. The check boxes about axis
are not available. The diagonal mass matrixM is structured as follows:

M = diag (M1,X,M1,Y,M1,Z,M2,X,⋯ ,Mn,j,⋯ ) (2.3)

where n = 1… FE-nodes and j = X, Y and Z directions

- Diagonal matrix (translational and torsional DOFs)

The masses in the translational directions X, Y, and Z as well as the masses acting about the
longitudinal axis of a member or surface are considered, if the check boxes about axis have been
selected. The direction that is taken into account depends on the local longitudinal directions
of the members and surfaces. The diagonal mass matrixM on a specific FE-point with massm is
structured as follows:

M = m ⋅ diag (1,1,1, Y2 + Z2, X2 + Z2, X2 + Y2) (2.4)

whereX, Y, orZ are thedistances to the centre of totalmass provided in theMassCase tabdescribed
in Section 2.2. The manually definedmass moments of inertia IX, IY and IZ as provided in the Nodal
Mass table (see Section 2.2.5) are also considered when acting in longitudinal direction.

- Diagonal matrix (translational and rotational DOFs) This type of mass matrix considers all
degrees of freedom. Themasses in the translational directions X, Y, and Z and rotational directions
X, Y, and Z are taken into account. The diagonal mass matrixM on a specific FE-point with massm
is structured as follows:

M = m ⋅ diag (1,1,1, (Y2 + Z2) + IX, (X2 + Z2) + IY, (X2 + Y2) + IZ) (2.5)

where X, Y, or Z are the distances to the centre of total mass (provided in the Mass Case tab
described in Section 2.2), and IX, IY, or IZ are the mass moments of inertia (defined in the Nodal
Mass table described in Section 2.2.5).
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Consistent Mass Matrix

The consistent mass matrix is a full mass matrix of the finite elements. Thus, the masses are not
simply lumped to the FE-nodes. Shape functions are used instead for a more realistic distribution
of the masses within the FE-elements. With this mass matrix, non-diagonal entries in the matrix
are considered, which means that mass rotation in general is taken into account. The structure of
the consistent mass matrix is as follows (neglecting the shape functions here for simplicity):

M = m ⋅

⎡
⎢
⎢
⎢
⎢
⎢
⎣

1 0 0 0 0 0
0 1 0 0 0 0
0 0 1 0 0 0
0 0 0 Y2 + Z2 −XY −XZ
0 0 0 −XY X2 + Z2 −YZ
0 0 0 −XZ −YZ X2 + Y2

⎤
⎥
⎥
⎥
⎥
⎥
⎦

(2.6)

where the massm and the distances X, Y, or Z refer to the centre of total mass given in theMass
Case tab described in Section 2.2.

Unit Matrix

The unit matrix overwrites all the previously defined masses. A unit matrix is a consistent matrix
with diagonal members of 1 kg. By using the Unit matrix, the mass at each FE-point is set to 1 kg.
Translations and rotations of the masses are considered. This mathematical approach should only
be used for numerical analyses. More details about matrix types and especially the use of the unit
matrix are provided by Barth and Rustler [5].

2.4.5 Eigenvalue Solver

There are different methods available to solve the eigenvalue problem. The choice is dependent
on the size of the structural system considered and is more a question of performance than of
accuracy. The methods are all suitable to determine accurate eigenvalues.

Root of the characteristic polynomial

This is the analytic solution of an eigenvalue problem, see for example [6] or [7]. It is solved using
a direct method. The main advantage of this method is the precision of higher eigenvalues and
that all eigenvalues of a model can be determined. For large structures this method can be quite
slow.

Lanczos

The method by Lanczos is an iterative method to determine the p lowest eigenvalues and cor-
responding mode shapes of large models. In most cases, this algorithm allows to reach a quick
convergence. It is possible to calculate n-1 eigenvalues (n = degrees of freedom of the system).
For further details see Bathe [6].

Subspace Iteration

The subspace iteration is appropriate for large FE-models where you want to calculate only a few
eigenvalues. All required eigenvalues are determined in one step. The computer memory limits
the number of eigenvalues that can be calculated by this method. For further details see Bathe [6].

ICG Iteration

This method is also suitable for large models where only a few eigenvalues are required. But here
the eigenvalues are calculated successively. Therefore, the number of required eigenvalues is
proportional to the computing time. Theoretically, all eigenvalues of a model can be calculated.
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2.4.6 FEMesh Settings

The button shown on the left links directly to the FEmesh settings of themain RFEM program. The
FEMesh Settings dialogue box is also available under Calculation→ FEMesh Settings in RFEM.
Further details about the FE mesh and the parameters that can be adjusted are explained in the
RFEMmanual, Section 7.2.

Members that are not integrated into surfaces are not divided into FE-nodes by default. When a
diagonal mass matrix is used, the mass of the member is lumped to the two end nodes. When
those end nodes are supported, you might not be able to calculate eigenvalues. In this case, you
need to activate the member division in the FE mesh settings.

2.4.7 Stiffness Modifications as Initial Conditions

Stiffness modifications can be imported from a specific Load case or Load combination. In detail
this means the following:

• Geometric stiffness matrix due to the influence of axial forces is added to the stiffness matrix
of the structure. This can be employed to approximately consider the P-Δeffect for the
calculation of frequencies, or to evaluate the influence of pre-stressing cables. Theory and
example when and how to consider the P-Δeffect can be found in FAQ 002316.

• Failed members, surfaces and supports due to the defined non-linearities in RFEM are im-
ported as initial conditions. Therefore, failed parts of the model are not available for the
calculation of eigenvalues. An example how this feature can be used to study the influence
of tension members in RF-DYNAM Pro is given in FAQ 002237.

• Stiffness factors for materials, cross-sections, members and surfaces are applied also in the
eigenvalue analysis when those are activated in the Calculation Parameters of the LC or CO.

• The factors set in theModify Stiffness tab of the LC or CO will be applied in RF-DYNAM Pro.

• The Extra Options settings of the LC or CO can be used to import the stiffness from the add-on
module RF-CONCRETE.

• Import of deactivated members, surfaces and solids. This modifies the structural system that
is analysed in RF-DYNAM Pro.

Calculation parameters
of LC or CO in RFEM

The calculation parameters of a load case or load combination that are relevant for RF-DYNAM Pro
are shown on the left hand side. The check boxesMaterials, Cross-sections,Members, and Surfaces
activate the modifications made in the material, cross-section, member, and surface dialogue
boxes in the main program RFEM (see RFEM manual, Sections 4.3, 4.13, 4.17, and 4.4). Further
details on the calculation parameters of load cases are given in the RFEMmanual, Section 7.3.

Global stiffnessmodifications can be imported from RFEM independently of any LC or CO. Those
global modifications import the material partial factor 𝛾M, cross-section, member and surface
modifications that are changed in RFEM (see RFEMmanual in Sections 4.3, 4.13, 4.17, and 4.4).

In RF-DYNAM Pro, those stiffness modifications are initial conditions. The calculation within RF-DY-
NAM Pro - Natural Vibrations is fully linear. You can activate the initial conditions as shown in
Figure 2.10.

When youwant to consider axial forces only,make sure that no stiffnessmodifications are activated
in the calculation parameters of the imported LC or CO.

When you want to study deactivated members only, make sure you create a load case containing
no loads but the stiffness modifications you are interested in.

A figure describing the complexity of this feature is provided in the Knowledge Base - 001023.

www.dlubal.com/en/support-and-learning/support/faq/002316
www.dlubal.com/en/support-and-learning/support/faq/002237
www.dlubal.com/en/support-and-learning/support/knowledge-base/001023
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2.5 Response Spectra

A response spectrum is a plot of the maximum peak response to a specified input illustrated
usually versus the natural period of single degree-of-freedom (SDOF) oscillators. It is produced by
calculating the response to a specific input (i.e. average of several earthquakemotions) for a family
of SDOF oscillators each having a different natural period but the same damping value. There
are computational advantages in using the response spectra method and it is a very common
method described in building standards. But you should be aware that it is only an approximate
method that calculatesmaximum internal forces of your system. For further details on the response
spectrum analysis, see for example Wilson [8] and Tedesco [9].

RF-DYNAMPro offers themulti-modal andmulti-point (only with RF-DYNAMPro - Forced Vibrations)
response spectrummethod. Ready to use response spectra curves are available in building stan-
dards, many of those are implemented in RF-DYNAM Pro. RF-DYNAM Pro can generate a response
spectrum from any given accelerogram (only available with RF-DYNAM Pro - Forced Vibrations).

The Response Spectra tab is only availablewhen the Response spectraor the Equivalent loadsoptions
have been selected in the General tab shown in Figure 2.1. This tab belongs either to the add-on
module RF-DYNAM Pro - Forced Vibrations or to the module RF-DYNAM Pro - Equivalent Loads.

In RF-DYNAM Pro, you have three options to enter response spectra: according to a building
standard, user-defined, or generated from an accelerogram. The Response Spectra tab is illustrated
in Figure 2.11.

Figure 2.11: Module Window Response Spectra with General tab – option According to Standard selected,
showing Code Parameters
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2.5.1 Response Spectra According to Building Standards

The parameters according to a building standard can be entered to generate a response spectrum.
The list of available building standards is provided in Figure 2.12.

Figure 2.12: List of implemented international and European building standards that regulate the earth-
quake design of structures and provide formulas for response spectra

Select a Standard from the drop-down list; the Code Parameters and their default values (see
Figure 2.11) change depending on the chosen standard. The parameters can be selected from
drop-down lists or entered manually depending on the type of parameter and depending on the
chosen building standard.

Many standards distinguish between a linear design spectrum employing the ductility factor q and
an elastic response spectrumemploying a damping correction factorη. Note the drop-downmenu
to choose between these types of spectra. Please note also the drop-down menu to distinguish
between horizontal and vertical response spectra definitions. The cells that are not editable
are determined by another parameter already set. For example in EN 1998-1 CEN [1], the ground
classesA to Edetermine the parameters TB, TC and TD; those parameters cannot be editedmanually.

When you change the ground type toOther, you can adjust the parameters TB, TC and TD manually
for the response spectra in accordance to EN 1998-1 [1].

The resulting response spectrum is illustrated in the graphic seen in Figure 2.11. The tool tip of
your mouse shows information about the displayed values. The values of the generated response
spectra are listed in the Table tab as shown in Figure 2.13.

Figure 2.13: Tabulated values of generated response spectrum

The values can be exported to Excel. The time Step should be adjusted before exporting the data.
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2.5.2 User-Defined Response Spectra

Any kind of response spectrum can be defined by entering the period T and corresponding accel-
erations Sa [m/s2] in the Table shown in Figure 2.14.

Figure 2.14: User-defined entry of response spectrum by defining Period T [s] and Acceleration Sa [m/s2]

User-defined response spectra can be stored in a library and can be opened whenever needed.
The [Save] button opens a dialogue box to enter a file name.

You can export your user-defined response spectra to Excel or import response spectra from Excel
by means of the respective buttons.

2.5.3 Response Spectra Generated from Accelerograms

The response spectra can be automatically generated from a given accelerogram.

This option is only available when Accelerations have been selected in the General tab shown in
Figure 2.1. This option belongs to the add-on module RF-DYNAM Pro - Forced Vibrations.

The available options to generate response spectra from an acceleration are shown in Figure 2.15.

Figure 2.15: Generated response spectrum from acceleration with graphics and tabular values
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The [Edit] button links to the Accelerogram tab described in Section 2.6 where you can define
acceleration-time diagrams or load accelerograms from a library of earthquake recordings. When
accelerograms are already defined, you can select the relevant entry from the drop-downmenu.

You can adjust the parameters as seen on the left. The generated response spectrum is illustrated
in the graphic below, and the values of period T and acceleration Sa are listed in the table (see
Figure 2.15). Both will be updated as soon as you change one of the parameters.

The viscous Damping d [%] is the damping of the SDOF oscillator family for which the maximum
system responses are calculated. The larger the damping is set, the fewer accelerations will be
generated.

The Number of periods determines the number of steps between the minimum and maximum
time (period), and determines therewith the number of data points generated.

TheMin time is the period of the first SDOF oscillator considered for the calculation. You see the
results in the first row in the table shown in Figure 2.15. TheMax time is the period of the last SDOF
oscillator considered for the calculation. You see the results in the last row in the table shown in
Figure 2.15.

The response spectra generated might be different in each direction as the accelerograms might
be different in each direction. You can change the displayed response spectra in the graphic and
table by using the radio buttons shown on the left.

You can export the generated response spectra to MS Excel.

2.6 Accelerograms
Accelerograms are acceleration-time diagrams usually recorded from previous earthquakes. In
RF-DYNAM Pro accelerograms can be used to generate response spectra or to perform a time
history analysis. In both cases the system can be excited on all or some supports.

The Accelerogram tab is shown in Figure 2.16.

Figure 2.16: Module window Accelerogramswith General tab
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The Accelerogram tab is only available when Accelerations have been selected in the General tab
shown in Figure 2.1. This tab belongs to the add-on modules RF-DYNAM Pro - Forced Vibrations
and RF-DYNAM Pro - Nonlinear Time History.

In RF-DYNAM Pro, you can load accelerograms from a library or enter themmanually.

2.6.1 Library of Earthquake Recordings

RF-DYNAM Pro provides a library with a large number of existing andmeasured accelerograms.
By now, more than 1018 accelerograms have been collected and stored in this library. In addition,
user-defined accelerograms can be saved in this library.

The library can be accessed with the button shown on the left. The library is shown in Figure 2.17.

Figure 2.17: Library containing a large number of earthquake recordings

You can Select the Accelerogram by country in the tree structure.

It is possible to sort the entries by Seismic event or Station. You can choose more filter criteria from
the drop downmenu. For example, it is possible to limit the accelerograms to a particular period
of time.

Each accelerogram is identified by its parameters. It is characterized by, for example, the country,
latitude and longitude and by the distance to the epicentre. Those data are provided on the
right-hand side of the library shown in Figure 2.17.

The chosen accelerogram is displayed in the graphic at the bottom of the dialogue box shown in
Figure 2.16. Most of the accelerograms differ in the three directions X, Y, and Z. You can switch
between those directions in the graphic.

Accelerograms loaded from the library can be saved with a different file name. The [Save] button
opens a dialogue box to enter a file name. Alternatively you can export the accelerograms to
Excel.
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2.6.2 User-Defined Acceleration-Time Diagrams

Any kind of acceleration-time diagram can be defined by entering the required values in the
Accelerogram table shown in Figure 2.18.

Figure 2.18: User-defined entry of acceleration-time diagram

User-defined accelerograms can be stored in a library and can be opened whenever needed. The
[Save] button opens a dialogue box to enter a file name.

You can export your user-defined accelerogram to Excel or import an acceleration-time diagram
from Excel.

The defined accelerogram is displayed in the graphic (see Figure 2.16). You can switch between
the X, Y, and Z-directions in the graphic.
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2.7 Time Diagrams

Time diagrams can be defined Transient, Periodic, or entered as Function. They excite the system
at a specific position. The load position is defined in static load cases (LC) where any type of load
can be entered. The static load cases (LC) are connected to the time diagrams (TD) in the Dynamic
Load Cases (see Section 2.10.2), and the multiplier k is used to determine the final value of the
excitation force.

The time diagram tab is only available when Time diagrams have been selected in the General tab
shown in Figure 2.1. This tab belongs to the add-on modules RF-DYNAM Pro - Forced Vibrations
and RF-DYNAM Pro - Nonlinear Time History.

2.7.1 Transient Time Diagrams

The TimeDiagram tab is illustrated in Figure 2.19 with an example of a transient time diagram. The
values can be entered in the table. The resulting time diagram is illustrated in the graphic at the
bottom. For each time step only one value of k shall exist.

Figure 2.19: Module Window Time Diagrams showing Transient time diagrams

The table entries can be stored in a library and can be opened whenever needed. Importing and
exporting from and to Excel is also possible.
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2.7.2 Periodic Excitation

To enter periodic functions, the Angular Frequency𝜔 [rad/s], the Shift𝜑 [rad], and theMultiplier k
have to be provided in tabular form. This is shown in Figure 2.20.

Figure 2.20: Module Window Time Diagrams showing Periodic time diagrams

Several harmonic functions can be overlain by filling several rows in the table. The periodic
functions are defined as follows:

f(t) = k1 ⋅ sin (𝜔1 ⋅ t + 𝜑1) + k2 ⋅ sin (𝜔2 ⋅ t + 𝜑2) + … (2.7)

The usual [Save], [Open], [Import] and [Export] functions are available.

2.7.3 Functions

You can enter the Function k(t) directly in the text box to define a time diagram. The parameter t is
reserved for the time. The resulting timediagram is displayed in thegraphic as shown in Figure 2.21.
The generated tabulated values are listed on the right hand side.

Figure 2.21: Module Window Time Diagrams showing Function time diagrams
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The valueMax t sets the maximum time for calculation; the time diagram k(t) = 0 for all t > tmax.
The Step size is used for the tabulated values in the table and for the automatic determination of
the time step for calculation (see Section 2.10.5).

All operators and functions that are available in RFEM can be also used in RF-DYNAM Pro. You can
use the parameters that you have defined in the main program RFEM. To avoid unit conversion, it
is recommended to employ dimensionless parameters in RF-DYNAM Pro. For more information
about the parametric input, consult Section 11.6 of the RFEMmanual.

The tabulated values can be saved to the library or exported to Excel.

A complex example of how the time diagram functions can be used is shown in theDLUBALwebinar
Time History Analysis in RF-/DYNAM Pro - Walking and Running Across Pedestrian Bridge.

2.8 Dynamic Load Cases

Dynamic load cases (DLC) combine the input that has been made so far and define the calculation
parameters for the analysis. Four different types of dynamic load cases are available: Response
spectrum analysis, linear and nonlinear Time history analysis of accelerograms, linear and nonlinear
Time history analysis of time diagrams, and Equivalent static force analysis.

The response spectrum analysis and the linear time history analysis belong to the add-on module
RF-DYNAMPro - ForcedVibrations, the nonlinear time history analysis belongs to the add-onmodule
RF-DYNAM Pro - Nonlinear Time History, and the equivalent static force analysis belongs to the
add-on module RF-DYNAM Pro - Equivalent Loads.

The General tab of the Dynamic Load Cases tab is shown in Figure 2.22.

Figure 2.22: Module Window Dynamic Load Caseswith General tab

Those options are only available when the specific add-on modules have been activated in the
General tab of RF-DYNAM Pro (see Figure 2.1).

www.dlubal.com/en/support-and-learning/learning/webinars/2015/2015-11-05-time-history-analysis-using-rf-dynam-pro
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For the linear time history analysis, two solvers are available – themodal analysiswhich is based
onmodal decomposition and requires a natural vibration analysis, and the implicit Newmark solver
which is a direct solver that does not require eigenvalues. For the nonlinear time history analysis,
two solvers are available as well – the implicit Newmark solver and an explicit solver. Details on the
time history solvers are provided in Section 2.10.3 and Section 2.10.4.

You have to assign a specific Natural vibration case (NVC) (discussed in Section 2.4) to the dynamic
load case for a response spectrum analysis, a modal analysis or an equivalent static force analysis.

The dynamic load case (DLC)) number is set automatically and cannot be edited. When a case is
deleted later, the numbers do not change. You can decide whether the specificDLC is to be solved
or not by selecting or clearing the To Solve option. You can also access this option in the shortcut
menu by right-clicking the corresponding DLC number.

You can calculate each dynamic load case separately by using its shortcut menu and applying
Calculate. The colour of a DLC is grey when no results of this dynamic load case are available yet.
It turns green as soon as the calculation has finished. For more information, see Section 3.3.

Load cases (LC) and/or result combinations (RC) are generated in each dynamic load case when
the check boxes in the To Generate section have been selected (see Response Spectra Analysis tab
in Figure 2.23, TimeHistory Analysis tab in Figure 2.26 and Figure 2.27, and Equivalent Force Analysis
tab in Figure 2.32). Those load cases and result combinations are generated automatically and are
overwritten when the RF-DYNAM Pro calculation is performed again. The descriptions of the load
cases and result combinations clearly refer to the originating DLCs.

You can enter the number of the first generated load case or result combination. RF-DYNAM
Pro does not overwrite existing load cases or result combinations (static or generated from other
add-on modules). It chooses the first unused LC or RC number available. Load cases and result
combinations from RF-DYNAM Pro are deleted when the results of the corresponding dynamic
load case (DLC) are deleted.

It is possible to activate the export options when the calculation is finished. A re-calculation is
hereby not required.

In the following sections of this manual, the Response Spectrum Analysis, the Time History Analysis
and the Equivalent Static Force Analysis are discussed in detail.
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2.9 Dynamic Load Cases - Response Spectrum Analysis

Amulti-modal and multi-point response spectra analysis is performed when the corresponding
radio button in Figure 2.22 is selected; this is only available in RF-DYNAM Pro - Forced Vibrations.
The definition of response spectra was discussed in Section 2.5. Mode shapes from the assigned
natural vibration case (NVC) can be selected for the analysis. The SRSSor theCQC rule is available for
modal combination. The calculation is done within the module RF-DYNAM Pro - Forced Vibrations
and is therefore completely linear. Stiffness modifications defined in the NVCs (Section 2.4.7) are
used for the analysis. The final results of the response spectrum analysis are exported to result
combinations (RC).

The sub-tabs when performing a response spectra analysis areGeneral, Response SpectrumAnalysis,
Damping, andMode Shapes. The Response Spectrum Analysis tab is illustrated in Figure 2.23.

Figure 2.23: Module Window Dynamic Load Caseswith Response Spectrum Analysis tab

2.9.1 Assign Supports

The supports that are excited by the response spectrum have to be assigned. You can either excite
all supports with identical response spectra, or you can use the multi-point option and create
several sets of supports.

You can create several Sets of supports by clicking . Switch in between the available sets by
using the drop-down menu. Use the button to delete a specific set. For each set, a list of
supported nodes, lines or surfaces must be provided. It can be entered manually or selected in
the work window via the button.

For background on the multi-point excitation, the reader is referred to the literature [8 and 10].
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2.9.2 Assign Response Spectrum

A specific response spectrum can be assigned in each direction. At least one of the directionsmust
have been selected. The relevant Response spectrum can be chosen from the drop-downmenu.
TheMultiplier factor can be adjusted independently for each direction.

The excitation direction can be rotated in the XY-plane about the Z-axis. For example, when
your response spectrum shall excite the structure 45 ° rotated about the Z-axis, activate only the
X-direction with your response spectrum and enter 𝛼 = 45 °.

For each set of supports, the response spectrum in each specific direction must be activated
separately. This allows for different response spectra for each set of supports.

2.9.3 Combination of Modal Responses

In these settings youdefinehow the responses resulting fromdifferent eigenvalues of the structure
are combined. The modal combination is the first step of dynamic combination.

The modal response can be combined using the Square Root of the Sum of the Squares (SRSS) rule
or the Complete Quadratic Combination (CQC) rule. Both of those quadratic combinations can be
applied in the standard form or modified as equivalent linear combination.

The standard form of SRSS combines maximum results. The signs are lost as seen in the formula
below:

RSRSS = √R2
1 + R2

2 + … + R2
p (2.8)

The combined results RSRSS result from the modal responses Rp from pmodes of the structure.

In RF-DYNAM Pro, a modified form of the SRSS rule is available in order to calculate corresponding
results, i.e. corresponding internal forces. Compared to the standard form of SRSS rule, those cor-
responding results are usually much smaller and the signs are correct in relation to the controlling
force. The SRSS rule is applied as equivalent linear combination [11] as follows:

RSRSS =
p

∑
i=1

fi ⋅ Ri with fi = Ri

√
p

∑
j=1

R2
j

(2.9)

By this formula the result combinations are consistent in itself.

The SRSS rule is only allowed for systems where adjacent natural periods Ti < TJ differ more than
10%, so when the following statement is true:

Ti
Tj

< 0.9 (2.10)

In all other cases, the CQC rule must be applied. The CQC rule is defined as follows:

RCQC =
√√√
⎷

p

∑
i=1

p

∑
j=1

Ri𝜀ijRj (2.11)

where the correlation coefficient 𝜀 is

𝜀ij =
8 ⋅ √DiDj (Di + rDj) r3/2

(1 − r2)2 + 4DiDjr (1 + r2) + 4 (D2
i + D2

j ) r2
with r =

𝜔j

𝜔i
(2.12)

The correlation coefficient 𝜀 simplifies when the viscose damping value D is equal for all modes to
the following:

𝜀ij = 8 ⋅ D2(1 + r)r3/2

(1 − r2)2 + 4D2r(1 + r)2
(2.13)
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The damping value Di that is required for the calculation of the correlation coefficient 𝜀ij is defined
in the Damping tab that appears as soon as you have selected the CQC rule. The settings for
damping are described below.

Analogously to the SRSS rule, the CQC rule can be applied as equivalent linear combination [11].
The CQC rule, still employing 𝜀ij as defined in Equation 2.12, is modified as follows:

RCQC =
p

∑
i=1

fi ⋅ Ri with fi =

p

∑
j=1

𝜀ijRj

√
p

∑
i=1

p

∑
j=1

Ri𝜀ijRj

(2.14)

Further information and mathematical derivations of the combination rules are provided in
[12–14].

2.9.4 Combination of Directional Components

In the settings you also define how the responses resulting from different excitation directions
are combined. The directional combination is the second step of dynamic combination.

The internal forces resulting from different excitation directions can be combined quadratically
with the SRSS rule, or using the 100% / 30% (40%) rule. The SRSS rule is applied as defined in Equa-
tion 2.8 but now i = 1..p are the excitation directions X, Y and Z. The SRSS rule for the directional
combination can also be realised as equivalent linear combination applying Equation 2.9.

2.9.5 Export Result Combinations

Whenyou selectCreate result combinations, RF-DYNAMPro automatically generates andoverwrites
result combinations during the calculation. The RCs are tied to the results, which means that they
are deleted as soon as the results of the DLC are deleted (see Section 3.3).

One RC is generated for the SRSS rule, but a maximum of three result combinations is generated
when you choose the 100% / 30% (40%) rule.

More information about the exported Result Combinations is provided in Section 4.2.

2.9.6 Damping for CQC rule

The Damping tab is only available when the CQC rule is chosen for the combination of mode
shapes (defined in Equation 2.11 and Equation 2.12).

For the CQC rule, the Lehr's damping values Di are needed. Those can be defined equally or
differently for each mode of the system. The Rayleigh damping with the coefficients 𝛼 and 𝛽 is
also available, but those values are internally converted to the Lehr's damping.

The Damping tab is shown in Figure 2.24.

Figure 2.24: Module Window Dynamic Load Caseswith Damping tab

For the conversion from Rayleigh coefficients 𝛼 and 𝛽 to the Lehr's damping Di it is referred to
Section 2.10.9.
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2.9.7 Mode Shape Selection

In the Mode Shapes tab illustrated in Figure 2.25, the natural frequencies ω and f as well as the
periods T are listed with the corresponding accelerations Sa of the response spectrum and the
effective modal mass factors fme in the translational directions. The assigned response spectrum
is illustrated in the graphic. Corresponding values are displayed in red when you have selected a
row in the table as shown in Figure 2.25.

Figure 2.25: Module Window Dynamic Load CaseswithModes Shapes tab – first mode selected in table

When no calculation has been performed yet, use the button [Calculate Mode Shapes] to calculate
the frequencies internally without closing the module.

In the table, you can select modes that shall be used for the response spectra analysis. All modes
will be selectedwhen the Select alloption is activated. In this case, the selection cannot be changed
manually. By using the Deselect modes with option, you can deactivate modes with an effective
modal mass factor below a specific value. When both check boxes are clear, you can select the
modes manually in the To Generate column.

The sums of the effective modal mass factors fme are shown at the bottom of the table. According
to EN 1998-1 Section 4.3.3.3 [1], the effective modal mass factors of all modes taken into account
shall be at least 90%. When this cannot be achieved, all modes with a factor above 5% shall be
taken into account. Further details about the effective modal mass factors and how those are
calculated are provided in Section 4.1.

You can switch between the excitation directions X, Y and Z in the graphic. Note that also the
values Sa in the table update depending on this choice.

The values Sa in the table and the diagram reflect the multiplier factors applied to each direction
(see Response Spectrum Analysis tab in Figure 2.23). Note that – if you have rotated your assigned
response spectrum around the angle 𝛼 – the directions X and Y are local directions in theMode
Shapes tab.

When you use the multi-point option and have defined several sets of supports in the Response
Spectrum Analysis tab (see Figure 2.23), the values of Sa in the table and the diagram in theMode
Shapes tab change depending on the selected set of support in the drop-downmenu.
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2.10 Dynamic Load Cases - Time History Analysis

A time history analysis is performed when either the Time history analysis of accelerograms or the
Time history analysis of time diagrams has been selected in the General sub-tab (see Figure 2.22).
The excitations and the results of a time history analysis are both data versus time.

The corresponding sub-tabs when performing a time history analysis are General, Time History
Analysis, Calculation Parameters, and Damping. The Time History Analysis tab is illustrated in Fig-
ure 2.26 and Figure 2.27. Note the difference in the user interface depending on the type of
excitation: Accelerograms excite the structure at the supports. The time history analysis of ac-
celerograms is discussed in Section 2.10.1. Time diagrams, however, can excite the structure
everywhere. The type of load and location of excitation is defined by load cases (LC) in RFEM. The
time history analysis of time diagrams is discussed in Section 2.10.2.

The timehistory analysis canbeperformed linearly, neglectinggeometrically and structural non-lin-
earities with the add-on module RF-DYNAM Pro - Forced Vibrations. Two linear solvers are avail-
able – the Linear modal analysis and the Linear implicit Newmark analysis. They are described in
Section 2.10.3.

A nonlinear time history analysis is available with the add-on module RF-DYNAMPro - Nonlinear
Time History. A large strain deformation analysis is performed under consideration of the defined
nonlinearities. Two nonlinear solvers are available – the Nonlinear implicit Newmark analysis and
the Explicit analysis. They are described in Section 2.10.4.

Time steps for the analysis are discussed in Section 2.10.5. The mass matrix settings are described
in Section 2.10.8 and the structural damping options in Section 2.10.9.

2.10.1 Time History Analysis of Accelerograms

Time history analysis of accelerograms is used to design the structure for the event of an earth-
quake. Accelerograms excite the structure at its supports.

Mü + D u̇ + Ku = −M üg (2.15)

in whichM is the mass matrix, D is the damping matrix and K is the static stiffness matrix. The
time dependent vectors u, u̇ and ü are the absolute displacements, velocities and accelerations.
üg is the ground acceleration which can be different in the different directions.

The definition of accelerograms was discussed in Section 2.6. In RF-DYNAM Pro, all supports can
be excited simultaneously with the same accelerogram. The multi-point option makes it possible
to excite single supports by different accelerograms (only available for linear solvers).

When nonlinearities play a role in the model, the time history of accelerograms might be favoured
compared to an response spectrum analysis.

The Time History Analysis sub-tab is illustrated in Figure 2.26.
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Figure 2.26: Module Window Dynamic Load Caseswith Time History Analysis tab of Accelerograms

Assign Supports
The supports that are excited by the accelerogram have to be assigned. When you consider all
supports to be identically excited, then those supports can be nodal, line or surface supports. The
multi-point option is available for nodal supports only at the moment. Supports defined with a
spring constant cannot be used for a time history analysis of accelerograms at the moment. The
multi-point option is only available for a linear time history analysis.

You can create several sets of supports by clicking the button. You can switch between the
sets by using the drop-down menu. Use the button to delete a specific set. For each set, a
list of supported nodes must be provided. It can be entered manually or selected graphically by
using the function.

For background on the multi-point excitation, the reader is referred to the literature [8 and 10].

Assign Accelerogram
Choose the available accelerograms from the drop-downmenu. You can apply differentmultiplier
factors in each direction.

The excitation direction can be rotated in the XY-plane about the Z-axis. For example, when your
accelerogram shall excite the structure 45 ° rotated about the Z-axis, activate only the X-direction
with your response spectrum chosen from the drop-downmenu and enter 𝛼 = 45 °.

You can assign a specific accelerogram to each set of supports.
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2.10.2 Time History Analysis of Time Diagrams

With a time history analysis of time diagrams, any point of the system can be excited in any
direction.

Mü + D u̇ + Ku = p(t) (2.16)

in whichM is the mass matrix, D is the damping matrix and K is the static stiffness matrix. The
time dependent vectors u, u̇ and ü are the absolute displacements, velocities and accelerations.
p(t) is the external excitation.

The definition of time diagrams was discussed in Section 2.7. In the Dynamic Load Cases, those
time diagrams are combined with load cases (LC) to define the type, the location and direction of
the excitation.

The Time History Analysis sub-tab is illustrated in Figure 2.27.

Figure 2.27: Module Window Dynamic Load Caseswith Time History Analysis tab of Time Diagrams

Loading - Time Diagram Sets
Load cases defined in the main program RFEM are to be combined with Time Diagrams (see
Section 2.7) to Loading - Time Diagram Sets. In the table, choose a load case by activating the list
via and allocate a time diagram to define the excitation of your structure. You can apply factors
for both the load case and the time diagram.

Static load cases are mandatory when performing a time history analysis of time diagrams. The
static load case defines the magnitude, direction and positions of the excitation. Nodal, line,
surface, free or generated loads can be combined with a function varying over time.

You can combine many of those Loading - Time Diagram Sets by filling more rows in the table as
shown in Figure 2.27. This is required to simulate an excitation that is varying in time but also
changing its position, e.g. a pedestrian walking across a bridge as demonstrated in the webinar
Time History Analysis in RF-/DYNAM Pro - Walking and Running Across Pedestrian Bridge.

www.dlubal.com/en-US/support-and-learning/learning/webinars/2015/2015-10-08-zeitverlaufsberechnung-mit-rf-dynam-pro
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2.10.3 Linear Solvers: Modal Analysis versus Implicit Newmark

In the General sub-tab (see Figure 2.22), you can choose between two linear time history solvers –
the Linearmodal analysis and the Linear implicit Newmark solver. The linear analysis is geometrically
linear (small deformations) and ignores or replaces all defined non-linearities in the model, i.e.
cables are replaced by trusses and failure of a support is ignored. The linear solvers belong to the
add-on module RF-DYNAM Pro - Forced Vibrations.

Themodal analysis uses a decoupled system based on the eigenvalues and mode shapes of the
structure, determined in the assigned natural vibration case (NVC). The multi-degree-of-freedom
(MDOF) system is transformed intomany single-degree-of-freedom-systems (SDOF) (diagonalized
mass and stiffness matrix). A certain amount of eigenvalues is required to ensure accuracy. The
solution of the decoupled system is then foundwith an implicit (Newmark) solver. Themassmatrix
settings and stiffness modifications are taken over from the NVC assigned. Initial deformations
can be applied. Once the eigenvalues are determined, the modal analysis provided in RF-DYNAM
Pro - Forced Vibrations is slightly faster than the linear implicit Newmark analysis.

The linear implicit Newmark solver is a direct time integration scheme that requires sufficient
small time steps to achieve accurate results. There is nonatural vibration analysis required. Settings
for the mass matrix are defined in the Calculation Parameters of the DLCs. Stiffness modifications
and initial deformations are not availablewith this type of solver. Formore theoretical background,
see e.g. [10]. The choice of time step is discussed in Section 2.10.5.

For the direct time history solver, dashpot elements can be used. This member type is available in
RFEM where you define the viscous damping coefficient c as well as the axial stiffness constant
(spring element) which is then acting parallel (Kelvin-Voigt-Model).

2.10.4 Nonlinear Solvers: Implicit Newmark versus Explicit

In theGeneral sub-tab (see Figure 2.22), you can choose between twononlinear timehistory solvers
– the Nonlinear implicit Newmark analysis and the Explicit analysis. Both nonlinear solvers perform
a large strain deformation analysis and consider all nonlinearities that are available in the main
program RFEM. The nonlinear solvers belong to the add-on module RF-DYNAM Pro - Nonlinear
Time History.

Theexplicit anaylsis, ormethodof central differences, is suitable for short duration excitations and
rapidly changing nonlinearities in the structure. The method is ‘explicit' because unknown values
depend only on the time i, not on the unknown response at time i + 1. The explicit integration rule
works well in combination with a diagonal mass matrix and with the restriction in damping matrix
C = 𝜶M. The method is conditionally stable. A bounded solution is obtained only when the time
increment 𝛥t is less than the stable time increment 𝛥tstable. The stability limit can be defined in
terms of the highest eigenvalue in the model 𝜔max and the fraction of critical damping D in the
highest mode.

𝛥tstable ≤ 2
𝜔max

(√1 + D2 − D) (2.17)

In practice, the stable time increment is estimated by

𝛥tstable = Le

cd
(2.18)

where Le is the finite element length and cd the dilatational wave speed that is for linear elastic
material (with Poisson's ratio equal to zero) equal to

cd = √ E
𝜌

(2.19)

where E is the Young's modulus and 𝜌 the material density.
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This estimation provides a smaller time step than the stability limit in Equation 2.17. Note also
that many effects are not included in the time step estimation and that for accuracy reasons an
even smaller time step Δtmay be required. RFEM uses a fixed time incrementation where the
fixed time step can be the initial stable time increment or a user-defined value.

Implicit schemes solve unknown values at time i + 1 based on the values at time i and i + 1. Thus,
nonlinear equations must be solved, iterations and convergence checks are required. The implicit
Newmark analysis is unconditionally stable, there is no upper stability bound in time step Δt.
Still, a reasonable small time increment is required to achieve accurate results. The time step
depends on the excitation, the frequency of the structure and the complexity of nonlinearities
in the structure. The implicit solver needs “time steps typically one or two orders of magnitude
larger than the stability limit of simple explicit schemes” [15]. There are no restrictions regarding
the mass matrix and Rayleigh damping when using the implicit Newmark solver.

The choice between the two nonlinear solvers depends mainly on the required time step but also
on the type of excitation. For both solvers, a time step convergence study must be done. For
further theoretical background, see [10 and 15–17].

For both nonlinear solvers, dashpots element can be used. This member type is available in
RFEM where you define the viscous damping coefficient c as well as the axial stiffness constant
(spring element) which is then acting parallel (Kelvin-Voigt-Model). The spring can be definedwith
slippage and/or as diagram. Those nonlinear features of dashpot elements are only applicable to
the nonlinear solvers.

2.10.5 Time Steps andMaximum Time

You need to define the time steps to be saved and themaximum time of your time history analysis.
Results are only available for the time steps that are saved, and also the dynamic envelope is built
from those saved time steps.

Saving less time steps reduces the file size, shortens the calculation time and improves the per-
formance of the post-processing. However, a certain amount of result values is required to avoid
skipping the maxima and to ensure a smooth graph in the Time Course Monitor (see Section 4.3).

Regardless of the time steps that are finally saved, you need to define the time steps used for the
calculation. A suitable choice of time step is essential for a successful time history analysis. It is a
compromise between calculation time and accuracy. A highly nonlinear calculation requires far
smaller time steps than a linear analysis. For the explicit solver, there exists a stable time increment
to obtain a solution.

For linear time history analysis, the following advice can be given [18]:

• Considering the accelerogram (see Section 2.6) and transient time diagram (see Section 2.7),
the shortest length of the discrete excitation shall be split into at least seven time steps.

• The highest frequency f of the structure (see Section 4.1) that is relevant for the time history
response shall be used to calculate the time stepwith𝛥t ≤ 1/(20 f). Analogously, the largest
frequency of the excitation (see Section 2.7) shall be checked with 𝛥t ≤ 𝜋 / (10𝜔).

You can define the time step for calculation manually, or RF-DYNAM Pro determines it automati-
cally.

For the modal analysis and the linear and nonlinear implicit Newmark solvers, RF-DYNAM Pro
chooses the time steps for calculation automatically according to the assigned excitation. For
accelerograms, transient and function time diagrams, the automatic time step is determined using
the time step in between the data points, 𝛥t = Min{ti+1 − ti}/7. For periodic time diagrams, the
automatic time step is determined with 𝛥t = 𝜋/(10𝜔) using the largest excitation frequency.

Note that this automatically determined time step is only in accordance to the excitation. Other
values, such as the frequency of the structure and non-linearities, are not taken into account, but
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they do influence the required time step. For the implicit solvers, it is therefore recommended to
define the time step for calculation manually.

The explicit solver determines the automatic time increment in accordance to the stability limit as
discussed in Equations 2.17 and 2.18. Usually, this time step is sufficient also in terms of accuracy.
Nevertheless, effects like e.g. rapid changes in stiffness are not included in the time step estimation.
For highly nonlinear systems, an even smaller time step Δtmay be required for accuracy reasons.

A time step convergence study should be performed in any case. It is essential for nonlinear time
history analyses.

2.10.6 Initial Deformation

When you select Initial deformations from load case, you can import initial conditions directly from
a load case. Those are the conditions at time step t = 0 s that are released shortly after.

In RF-DYNAM Pro, the initial deformations are only available when themodal analysis has been se-
lected. For the direct solvers the functions Initial condition and Stationary state are available. These
functions can be selected in the Calculation Parameters tab and are described in Section 2.10.8.

2.10.7 Export of Load Cases and Result Combinations

You can export load cases for single time steps by activating the Generate load cases check box.
Select the Load case type from the drop down list below. The exported load cases will not contain
any loads: they contain the results at the specific time step.

In the list shown in Figure 2.28, you can Select time steps that are to be exported.

Figure 2.28: Dialogue box Select Time Steps for export

A result combination (RC) as a result envelope with maximum andminimum values of all saved
time steps is generated when you select the Create result combination option.

More information on the exported load cases and result combination is provided in Section 4.3.
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2.10.8 Calculation Parameters

The calculation parameters of time history DLCs are only available for direct solvers, such as the
linear and nonlinear implicit Newmark solver and the explicit solver. Here, you define themassmatrix
and the directions of acting masses. The Calculation Parameters sub-tab is shown in Figure 2.29.

Figure 2.29: Module Window Dynamic Load Caseswith Calculation Parameters tab (direct solvers only)

In case of theModal Analysis, the settings of acting masses, mass matrix and FE mesh settings are
taken over from the assigned NVC.

ActingMasses
You can import a specificMass cases orMass combination into each DLC. Those have been defined
as described in Section 2.2 and Section 2.3. Select the relevant mass case or combination from the
drop-downmenu.

You have to define the direction in which themasses are acting. Themasses act in the global trans-
lational X, Y, or Z-directions when you select the corresponding check boxes. They act rotationally
about the globalX, Y, and Z-axeswhen the corresponding check boxes have been activated. Those
settings change your mass matrix.

When the explicit solver is used, masses have to act on each FE-node and in all directions.

Type of Mass Matrix
There are four types ofmassmatrices available in this section of the Calculation Parameters sub-tab
(see Figure 2.29). The different types of mass matrices are discussed in Section 2.4.4.

The explicit solver is restricted to the Diagonal matrix (translational and rotational DOFs).

FEMesh Settings

The button links directly to the FE mesh settings of the main program RFEM. The FE Mesh
Settings dialogue box is also available in the Calculation → FE Mesh Settingsmenu of RFEM.
Further details on the FEmesh and the parameters that can be adjusted are described in the RFEM
manual, Section 7.2.

Members that are not integrated into surfaces are not divided into FE-nodes by default. When
a diagonal mass matrix is used, the mass of a member is lumped to the two end nodes of the
member. For a more refined distribution of the mass, you need to activate the member division in
the FE mesh settings.
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Initial Condition and Stationary State
The functions Initial condition and Stationary state are available. With the option Initial condition all
conditions from the selected load case or load combination at time step t = 0 s are imported and
then released shortly after. The function Stationary state considers all conditions over the entire
time.

In addition to the imported deformations and loads used to establish an equilibrium state at the
beginning of the calculation, all stiffness modifications made in the settings of the load cases and
load combinations are taken into account. These have already been explained in Section 2.4.7.
Furthermore the states of nonlinearities are imported in the nonlinear solvers.

It is possible to choose between load cases and load combinations. For the linear solver, only load
cases or load combinations can be used which are calculated according to a geometrically linear
analysis. Load cases and load combinations which are calculated according to a large deformation
or postcritical analysis can only be used for one of the two nonlinear solvers, however.

2.10.9 Structural Damping

In RF-DYNAM Pro, structural viscose damping is available. It can be defined by the Rayleigh
coefficients 𝛼 and 𝛽 or the Lehr's damping values Di. The Lehr's damping value can be equal or
different for each mode of the system.

The Damping sub-tab is shown in Figure 2.30.

Figure 2.30: Module Window Dynamic Load Caseswith Damping tab

With the Rayleigh damping coefficients, the damping matrix C is defined as

C = 𝜶M + 𝜷K (2.20)

using the factors 𝛼 and 𝛽 . The Rayleigh damping coefficients are used for the linear and nonlinear
implicit Newmark and the explicit solver. The damping matrix C does not need to be a diagonal
matrix for the direct time history solvers. For more information about the Rayleigh damping, see
for example [18].
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The Lehr's damping values Di are used for themodal analysis. The dampingmatrix C needs to be a
diagonal matrix. The Lehr's damping values are defined for each single mode i as a factor between
the existing and the critical damping as follows:

Di = ci
2 ⋅ mi ⋅ 𝜔i

(2.21)

where ci are the entries in the diagonal damping matrix,mi the modal masses, and 𝜔i the angular
frequencies of the system.

The Rayleigh coefficients and the Lehr's damping are connected as follows:

Di = 1
2

( 𝛼
𝜔i

+ 𝛽 𝜔i) (2.22)

This equation is visualised in Figure 2.31 using the Rayleigh coefficients𝛼 = 0.2 and 𝛽 = 1× 10−3.
It gets clear that for one set of Rayleigh coefficients different values of Lehr's damping result for
each natural frequency of the structure.

RF-DYNAM Pro internally converts the Rayleigh damping coefficients 𝛼 and 𝛽 into the Lehr's
damping values Di if themodal analysis is selected. In this case, the solution is unique.

Figure 2.31: Relation between Rayleigh coefficients 𝛼 and 𝛽 and the Lehr's damping D using the examples:
1 – Total: 𝛼 = 0.2 and 𝛽 = 1 × 10−3

2 – 𝛽-Damping: 𝛼 = 0.0 and 𝛽 = 1 × 10−3

3 – 𝛼-Damping: 𝛼 = 0.2 and 𝛽 = 0.0
Illustrated are the Lehr's damping values resulting for each angular frequency𝜔 of the structure.

For the implicit and explicit solver, the Rayleigh coefficients have to be specified. You can convert
Lehr's damping values Di to Rayleigh coefficients 𝛼 and 𝛽 by clicking the button: in a new
dialog box, define themost dominant frequencies of yourmodel in combinationwith the required
Lehr's damping values.

The conversion from Lehr's damping values to Rayleigh coefficients is illustrated in the example
in Section 5.2.
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2.11 Dynamic Load Cases - Equivalent Load Analysis

The equivalent load analysis is performed when the corresponding radio button in Figure 2.22 is
selected; it belongs to the add-on module RF-DYNAMPro - Equivalent Loads. The equivalent load
analysis in RF-DYNAM Pro is based on the multi-modal response spectra analysis.

Themain differences to the Response Spectra Analysis in the add-onmodule RF-DYNAMPro - Forced
Vibrations described in Section 2.9 are listed below:

• Load cases with equivalent loads are exported to RFEM separately for each mode and each
excitation direction.

• The calculation of load cases is done in the main program RFEM. Thus, nonlinearities are
considered by default, but stiffness modifications defined in the NVCs are not taken over.

• Accidental torsional actions can be considered automatically.

• Base shear forces can be easily evaluated separately for each mode.

• Result combinations are produced separately for each excitation direction (combined modal
responses with SRSS or CQC) and for the combination of results from different excitation
directions (SRSS, 100% / 30% (40%)).

• A signed result option is available that provides unique RCs using the signs of the dominant
mode shape.

• The results are reproducible step by step.

• All supports are excited identically (no multi-point option).

The corresponding sub-tabs when performing an equivalent load analysis are General, Equivalent
Force Analysis, andMode Shapes. The Equivalent Force Analysis sub-tab is illustrated in Figure 2.32.

Figure 2.32: Module Window Dynamic Load Caseswith Equivalent Force Analysis tab



2 Input Data

©DLUBAL SOFTWARE 2020

47

2
2.11.1 Assign Response Spectrum

In each direction, a specific Response spectrum can be assigned. At least one of the directions
must be selected. The response spectrum (RS) can to be chosen from the drop-downmenu. It is
possible to adjust the multiplier Factor independently for each direction.

The excitation direction can be rotated in the XY-plane about the Z-axis. For example, when
the response spectrum shall excite the structure 45 ° rotated about the Z-axis, activate only the
X-direction with your response spectrum chosen from the drop-downmenu and enter 𝛼 = 45 °.

2.11.2 Accidental Torsional Actions

RF-DYNAM Pro considers accidental torsion actions automatically when you have selected the
corresponding check box and the eccentricities eX and eY have been defined. This is regulated in
EN 1998-1 Sections 4.3.2 and 4.3.3.3.3 [1], for example. The eccentricities eX and eY define how
far the centre of mass is displaced, to account for uncertainties in the location of masses. For the
calculation of the equivalent loads and the torsional moments, see Section 4.4.1 and Section 4.4.2.

When you export load cases with generated equivalent loads, two load cases will be generated
for each mode shape and each direction – one with positive torsional moments, and one with
negative torsional moments. RF-DYNAM Pro creates an alternative combination of those two
load cases. More information on howmodal combinations are applied when accidental torsional
actions are activated are reported in the Knowledge Base - 001118.

2.11.3 Combination of Modal Responses

In the dialogue box section Combination of Modal Responses, you define how the responses result-
ing from different eigenvalues of the structure are to be combined. The modal combination is the
first step of dynamic combination.

The modal response can be combined using the Square Root of the Sum of the Squares (SRSS) rule
or the Complete Quadratic Combination (CQC) rule. Both of those quadratic combinations can be
applied in the standard form or modified as equivalent linear combination. The option Signed
Results provides modal combinations with unique signs using the dominant mode shape of the
structure.

The standard form of SRSS combines maximum results; the signs are lost. The formula is provided
below:

RSRSS = √R2
1 + R2

2 + … + R2
p (2.23)

The combined results RSRSS result from the modal responses Rp from pmodes of the structure.

RF-DYNAMPro includes amodified formof the SRSS rule in order to calculate corresponding results,
i.e. corresponding internal forces. Compared to the standard form of the SRSS rule, those corre-
sponding results are usually much smaller and the signs are correct in relation to the controlling
force. The SRSS rule is applied as equivalent linear combination [11] as follows:

RSRSS =
p

∑
i=1

fi ⋅ Ri where fi = Ri

√
p

∑
j=1

R2
j

(2.24)

By this formula the result combinations are consistent in itself.

The SRSS rule is only allowed for systems where adjacent natural periods Ti < TJ differ more than
10%, i.e. when the following statement is true:

Ti
Tj

< 0.9 (2.25)

www.dlubal.com/en/support-and-learning/support/knowledge-base/001118
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In all other cases, the CQC rule must be applied. The CQC rule is defined as follows:

RCQC =
√√√
⎷

p

∑
i=1

p

∑
j=1

Ri𝜀ijRj (2.26)

where the correlation coefficient 𝜀 is

𝜀ij =
8 ⋅ √DiDj (Di + rDj) r3/2

(1 − r2)2 + 4DiDjr (1 + r2) + 4 (D2
i + D2

j ) r2
where r =

𝜔j

𝜔i
(2.27)

If the viscose damping value D is equal for all modes, the correlation coefficient 𝜀 simplifies to:

𝜀ij = 8 ⋅ D2(1 + r)r3/2

(1 − r2)2 + 4D2r(1 + r)2
(2.28)

The damping value Di that is required for the calculation of the correlation coefficient 𝜀ij is defined
in theDamping tab. It appears as soon as you have selected the CQC rule. The settings for damping
are described below.

Analogously to the SRSS rule, the CQC rule can be applied as equivalent linear combination [11].
The CQC rule, still employing 𝜀ij as defined in Equation 2.27, is modified as follows:

RCQC =
p

∑
i=1

fi ⋅ Ri where fi =

p

∑
j=1

𝜀ijRj

√
p

∑
i=1

p

∑
j=1

Ri𝜀ijRj

(2.29)

You can find more information on the option Use equivalent linear combination and an example in
the Knowledge Base - 001098.

When the CQC rule is applied, the exported load cases contain information on the corresponding
angular frequency 𝜔 and the applied damping Di.

You can find more information on the CQC rule and an example in the Knowledge Base - 001263.
Independently of RF-DYNAM Pro, the CQC rule is available in the main program RFEM. This is
described in the Knowledge Base - 001259.

With the usual quadratic combinations like the SRSS and CQC rule, all maxima are positive and
all minima are negative in the produced result envelope. The signs of results are lost and the
results combinations are not unique. To overcome this side effect of quadratic combinations and
to produce a more realistic representation of internal forces, the so-called Signed Results option
is available in RF-DYNAM Pro. When the structure has a dominant eigenvalue, the signs of the
corresponding load case can be applied to the results in the result combination. This leads to
unique result combinations (RC). When you choose Automatic in the drop-down list, RF-DYNAM
Pro selects the dominant mode shape automatically by means of the largest effective modal mass
factor. You can also select any other eigenvalue manually.

You can find more information on the Signed Results option and an example in the Knowledge
Base - 001278.

Further information and mathematical derivations of the combination rules are provided in e.g.
[12–14].

www.dlubal.com/en/support-and-learning/support/knowledge-base/001098
www.dlubal.com/en/support-and-learning/support/knowledge-base/001263
www.dlubal.com/en/support-and-learning/support/knowledge-base/001259
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/001278
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/001278
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2.11.4 Combination of Directional Components

The internal forces resulting from different excitation directions can be combined quadratically
with the SRSS rule, or by using the 100% / 30% (40%) rule. The SRSS rule is applied as defined in
Equation 2.23, but now i = 1..p are the excitation directions X, Y, and Z. The SRSS rule for the direc-
tional combination can also be realised as equivalent linear combination applying Equation 2.24.

2.11.5 Export of Load Cases and Result Combinations

When you select the Load cases check box, load cases are exported to RFEM separately for each
mode and separately for each excitationdirection. The equivalent loads are calculated in according
to Equation 4.9, Equation 4.10, and Equation 4.11.

When you select Result combination (modal combination) and Combination of directional compo-
nents, several result combinations are automatically generated.

• RCs containing the modal response combination (SRSS or CQC) separately for each direction.

• RCs combining the results in the different excitation directions. One RC is generated for the
SRSS rule, but a maximum of three RCs are generated for the 100% / U[30 percent] (40%) rule.

More information on the exported load cases and result combinations is provided in Section 4.4.

2.11.6 Damping for CQC Rule

The Damping tab is only available when the CQC rule has been selected for the combination of
mode shapes (defined in Equation 2.26 and Equation 2.27).

For the CQC rule, the Lehr's damping values Di are needed. Those can be defined equally or
differently for each mode of the system. The Rayleigh damping with the coefficients 𝛼 and 𝛽 is
also available, but those values are internally converted to the Lehr's damping. The Damping tab
is the same as for the Response Spectrum Analysis. It is shown in Figure 2.24 in Section 2.9.6.

For the conversion of the Rayleigh coefficients𝛼 and 𝛽 to the Lehr's dampingDi, see Section 2.10.9.

2.11.7 Mode Shape Selection

RF-DYNAM Pro - Equivalent Loads provides a multi-modal response spectra analysis. You can
select as many modes as important for the analysis. The Mode Shape tab and its settings are
discussed in detail in Section 2.9.7 and are the same for the equivalent load analysis.
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2.12 GlobalDetails Settings

The Details dialogue box can be accessed by pressing the [Details] button. You can also open it
via Settings → Details. In this dialogue box, you can set global parameters that are valid for the
overall dynamic calculation and independent of any defined case within the module.

The Details dialogue box is shown in Figure 2.33.

Figure 2.33: Details dialogue box with global parameters concerning RF-DYNAM Pro

Mass Conversion Type

In Section 2.2, the mass import from load cases is explained. Section 2.2.4 provides details on the
different types of mass conversions.

Neglect Masses

Masses on nodes, lines, members, and surfaces can be neglected in the dynamic analysis. In
Section 2.2.4, details on the Neglect Masses feature are provided.

Display Response Spectra

You can change the display of the response spectra as seen in Figure 2.11 and Figure 2.25. The
default display uses a linear x-axis, but it is possible to change it to a logarithmic scale.

MinimumAxial Strain for Cables andMembranes

These special types of members and surfaces require a minimum axial strain. If the limit is set too
small, the eigenvalues achieved are not realistic and only local mode shapes are determined. The
default value is applicable for most cases. You can findmore details on cables in the RFEMmanual,
Section 4.17.

Instability Detection

The stability of a system can be analysed. For it, the default value in RF-DYNAM Pro is set to 0.01,
which means a very sensitive detection of instability and an early break-off limit. Please see RFEM
manual, Section 7.3.3 for further details.
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Equivalent Loads

As discussed in Section 2.11, load cases are exported containing the generated equivalent loads.
Loads can only be viewed in the graphic when less than 5,000 loads are produced. You can change
this value here, but note that the process of displaying more than 5,000 loads is slow.

The maximum number of loads that RFEM can produce and export to load cases is 99,999. As
equivalent loads are generated on each FE-node, you can only get a full set of equivalent loads
when your structure has less than 99,999 FE-nodes. When your structure has more FE-nodes, the
smallest equivalent loads are neglected, and only 99,999 loads will be exported. You can adjust
the maximum number of generated equivalent loads in the Details dialogue box.

2.13 Units and Decimal Places

You can access the Units and Decimal Places dialogue box with the button shown on the left. The
dialogue box is shown in Figure 2.34.

Figure 2.34: Dialogue box Units and Decimal Places showing settings of RF-DYNAM Pro Input Data

Select the add-on module RF-DYNAM Pro in the list of modules. The Input Data tab is opened.
There you can choose the units from the drop-downmenus and adjust the decimal places.
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3 Calculation

3.1 Check
Before starting the calculation, you can check the input data without closing the add-on module.
Click [Check] in the bottom part of the module.

The module shows the Input Data Verification dialogue box displaying any warning and error
messages. When no errors have been found, the message No consistency errors found is displayed.

Figure 3.1: Dialogue box Input Data Verification showing messages

When you click [OK & Calculate], the check is also performed. If an error is detected, the Input Data
Verification dialogue box is shown and you can decide whether you want to perform or cancel the
calculation.

3.2 Start Calculation
To start the calculation, click the [OK & Calculate] button. RF-DYNAM Pro then calculates all cases
(NVCs and DLCs) where no results are available and which have been selected to be solved (To
Solve check box). The add-on module closes once the calculation has finished.

To start the calculation of a singlec natural vibration case (NVC) or dynamic load case (DLC), you
can right-click the specific case and select Calculate. Only the selected case will be calculated
by RF-DYNAM Pro. When the calculation has finished, the module stays open. The colour of the
selected case changes from grey to green. When you calculate a DLC, the assigned NVC will be
calculated as well.

You can also start the calculation in the RFEM user interface. To calculate the RF-DYNAM Pro case
directly, select it from the list in the RFEM toolbar shown in Figure 3.2. Click the [Show Results]
button to perform the calculation. All cases (NVCs and DLCs) will be calculated where no results
are available and which have been selected to be solved (To Solve check box).

Figure 3.2: Direct calculation of RF-DYNAM Pro case in RFEM

The To Calculate dialogue box (Calculate → To Calculate) lists the add-on module cases as well
as load cases and load combinations. This is shown in Figure 3.3.
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Figure 3.3: Dialogue box To Calculate

You can filter the available cases with the drop-downmenu shown on the left.

To transfer the selected RF-DYNAM Pro case to the list on the right, use the or button.
Click [OK] to start the calculation. All cases (NVCs and DLCs) will be calculated where no results are
available and which have been selected to be solved (To Solve check box).

When you have started the calculation, you can observe the analysis process in a separate dialogue
box shown in Figure 3.4.

Figure 3.4: Process of RF-DYNAM Pro calculation



3 Calculation

©DLUBAL SOFTWARE 2020

54

3

3.3 Availability of Results

The process to delete and calculate cases in RF-DYNAM Pro is differentiated: Cases like natural
vibration cases (NVCs) and dynamic load cases (DLCs) can be calculated separately, and also the
results can be deleted separately by using the shortcut menu (right-click the specific case). The
shortcut menu also offers to delete the case, set the case To Solve or Not to solve.

The colour of a case is grey when no results are available. The color of a case is green when results
are available; then also the exported LCs and RCs do exist. Exported RCs and LCs are tied to the
results, i.e. they will be deleted as soon as the results of a case are deleted.

The results of a specific case will be deleted, when

• you use the shortcut menu to delete the results,

• something is changed in the NVC or DLCwithin RF-DYNAM Pro,

• assigned mass cases (MC), mass combinations (MCO), natural vibration cases (NVC), response
spectra (RS), accelerograms (AC) or time diagrams (TD) change,

• assigned load cases LC or load combinations CO change.

Results of a specific case will not be deleted, when

• the description of the case is modified,

• comments are made in the General tab,

• the scaling of mode shapes is altered in a NVC,

• the export settings are changed in a DLC (button [OK & Calculate] updates only the exported
LCs and RCs).
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4 Results
The results of RF-DYNAMPro are embedded in themain programRFEM. The general interpretation
of the results is described in Sections 8 and 9 of the RFEMmanual.

Figure 4.1 shows the main program RFEM. The results of a Natural Vibration Case are displayed,
the first mode shape is illustrated, and the natural frequencies are listed in the table.

Figure 4.1: Results of a Natural Vibration Case in main program RFEM

The Display navigator and the Results navigator are explained in Section 3.4.3 of the RFEMmanual,
the Tables in Section 3.4.4 and the Control Panel in Section 3.4.6. In this RF-DYNAM Pro manual,
only the newly available results will be discussed.

You can access all relevant results tables of your dynamic analysis with the [Dynamic Analysis]
button.

Each of the results tables discussed in this chapter can be exported to MS Excel. The values within
the tables are saved as strings, so only the number of decimal places that are displayed will be
exported. If you need a higher accuracy, you have to adjust the decimal places in the Unit and
Decimal Places dialogue box accessible with the button.

All dynamic results tables can also be exported via File→ Export. You can choose to export all
dynamic tables or only selected tables as shown in Figure 4.2. The results that are available for
each dynamic case are detailed in the following sections. Analogously you can export the data to
the CSV file format.

With the drop-downmenu, you can switch between the available natural vibration cases (NVC) and
dynamic load cases (DLC). You can also switch between the cases using the and buttons.
The available results tables depend on that selection. This is clarified in the following sections.

The graphic in the work area of RFEM is also updated according to the selected NVC or DLC. All
results which are usually available in RFEM are accessible in the same way for the RF-DYNAM Pro
results. The interaction between tables and graphic works as common for RFEM.
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Figure 4.2: Dialogue box Export to Microsoft Excel - Settings to export all dynamic tables (NVCs and DLCs)

4.1 Natural Vibration Cases

The results tables that belong to natural vibration cases are available when a NVC case has been
selected in the drop-downmenu. The corresponding table numbers are 5.1 through 5.7. Those
results tables are always available; they belong to the module RF-DYNAM Pro - Natural Vibrations.
The input data required for natural vibration cases (NVC) is discussed in Section 2.4.

You can switch between the available mode shapes in the work window by using the drop-down
menu shown on the left or the and buttons. The maximum deformation displayed in the
graphics depends on the scaling option; this is discussed in Section 2.4.2.

The animation of the mode shapes can be activated via the button in the main toolbar (see
Figure 4.1).

4.1.1 Natural Frequencies

Table 5.1 provides the natural frequencies of the undamped system. The results table is shown in
Figure 4.3.

Figure 4.3: Table 5.1 Natural Frequencieswith eigenvalues 𝜆 [1/s2], angular frequencies 𝜔 [rad/s], natural
frequencies f [Hz], and natural period T [s]
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The equation of motion of a multi-degree of freedom without damping is solved with the four
available eigenvalue solvers discussed in Section 2.4.5. Further theoretical details can be found
e.g. in BATHE [6] or TEDESCO [9]. The equation of motion is defined as

Mü + Ku = 0 (4.1)

whereM is themassmatrix discussed in Section 2.4.4,K the stiffnessmatrix. u are themode shapes
containing translational and rotational parts:

u = (uX,uY,uZ,𝜑X,𝜑Y,𝜑Z)
T (4.2)

The eigenvalue 𝜆 [1/s2] is connected to the angular frequency 𝜔 [1/s] with 𝜆i = 𝜔2
i . The natural

frequency f [Hz] is then derived with f = 𝜔/2𝜋 , and the natural period T [s] is the reciprocal of the
frequency obtained with T = 1/f.

For a multi-degree of freedom (MDOF) system, several eigenvalues 𝜆i and corresponding mode
shapes ui exist for each mode i.

4.1.2 Mode Shapes

Each frequency of the system has a correspondingmode shape. Thesemode shapes are illustrated
graphically in the work area of RFEM. You can use the drop-downmenu to switch between the
mode shapes; this was discussed above.

All mode shapes are tabulated in Tables 5.2, 5.3, 5.4 and 5.5. The difference in those tables are the
way how the values are sorted. In Table 5.2, the standardised displacements uX, uY, and uZ and
rotations 𝜑X, 𝜑Y, and 𝜑Z are sorted by nodes. This table is illustrated in Figure 4.4.

Figure 4.4: Table 5.2 Mode Shapes by Nodewith standardised displacements uX, uY, and uZ and rotations
𝜑X, 𝜑Y, and 𝜑Z

Table 5.3 lists the values sorted by members, Table 5.4 sorted by surfaces, and Table 5.5 sorted by
mesh points. If there are no surfaces in the model, Table 5.4 does not exist.

The maximum values of u and 𝜑 are dependent on the selected scaling option discussed in Sec-
tion 2.4.2. The standardised displacements u are dimensionless, and the standardized rotations 𝜑
are given in [1/m]. Those units result from the scaling procedure.
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4.1.3 Masses in Mesh Points

The calculation of the masses in mesh points depends on the imported masses (see Section 2.2),
on the settings in theDetails dialogue box (see Section 2.12), and on the finally assignedmass case
(MC) or mass combination (MCO (see Section 2.4.3). In Table 5.6, the masses in the translational
directionsmX,mY, andmZ are provided. The sums of the masses are given at the bottom of the
table. Table 5.6 is shown in Figure 4.5. The coordinates of themesh points in the global coordinate
system are listed as well.

Figure 4.5: Table 5.6Masses inMesh Pointswith translational directionsmX,mY, andmZ for eachmesh point
and sums of masses

4.1.4 Effective Modal Mass Factors

Table 5.7 provides the modal massesMi, the effective modal massesme, and the effective modal
mass factors fme. It is illustrated in Figure 4.6. The effective modal masses describe how much
mass is activated by each eigenvalue of the system in each direction.

Figure 4.6: Table 5.7 Effective Modal Mass Factorswith modal massesMi, effective modal massesme, and
effective modal mass factors fme related to global axes

The modal mass is defined with

Mi = u T
i ⋅ M ⋅ ui (4.3)

where ui is the eigenvector of a single mode i as defined in Equation 4.2, and M is the mass
matrix discussed in Section 2.4.4. The modal mass Mi is independent of direction. It changes
depending on the scaling option chosen for the mode shapes (see Section 2.4.2); when the option
uT
i Mui = 1 kg is chosen, all modal masses areMi = 1 kg.
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The effective modal massesmeff

ij provide the masses that are accelerated in the j-direction, where
j = 1,2,3 for translations and j = 4,5,6 for rotations, separately for each mode i. Those masses
are independent of the scaling option for mode shapes, and directly related to the participation
factors 𝛤i,j.

𝛤i,j = 1
Mi

u T
i MTj (4.4)

where Tj is the j
th column in matrix T

T =

⎡
⎢
⎢
⎢
⎢
⎢
⎣

1 0 0 0 (Z − Z0) −(Y − Y0)
0 1 0 −(Z − Z0) 0 (X − X0)
0 0 1 (Y − Y0) −(X − X0) 0
0 0 0 1 0 0
0 0 0 0 1 0
0 0 0 0 0 1

⎤
⎥
⎥
⎥
⎥
⎥
⎦

(4.5)

X, Y, and Z are the global coordinates of the considered FE-node provided in Table 5.6 (see Fig-
ure 4.5), X0, Y0 and Z0 are the centres of total mass provided in theMass Cases → General tab in
RF-DYNAM Pro (see Section 2.2). This matrix T exists for each FE-node. The definition of the partic-
ipation factors defining also the rotational degrees of freedom is detailed in [19], Section 15.7.5.
The participation factor 𝛤ij is dimensionless for translations and has the unit [m] for rotations.

The effective modal masses are defined with

meff
ij = Mi ⋅ 𝛤 2

ij (4.6)

where the effectivemasses for translationsmeX,meY, andmeZ are provided in [kg] and for rotations
mu�X,mu�Y, andmu�Z in [kgm2].

The sums of the effective modal masses ∑me are provided in Table 5.7 (see Figure 4.6). In the
translational directions, those sums are equal to the total sum of the structureMtotal (see Table 5.6
in Figure 4.5) beside masses that are not activated, i.e. masses in fixed supports, and assuming
that all eigenvalues of the system are calculated.

The effective modal mass factors fme are required to decide whether or not a specific mode must
be taken into account for the response spectra analysis or the equivalent load analysis. EN 1998-1
[1] states in Section 4.3.3.3 that “the sum of the effective modal masses for the modes taken into
account” needs to be “at least 90% of the total mass of the structure” and that “all modes with
effective modal masses greater than 5% of the total mass” have to be taken into account .

The effective modal mass factors fme are defined as follows:

fme = me

∑me
(4.7)

Further details on modal analysis can be found in the literature, e.g. Meskouris [20] or Tedesco [9].
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4.1.5 Export to Excel or CSV

You can export all results tables that have been discussed in this section to MS Excel or save them
in the CSV format using the File → Export option. The list of results tables is shown in Figure 4.7.

Figure 4.7: Results tables to export for natural vibration cases (NVC)

4.2 Dynamic Load Cases - Response Spectra Analysis

The results tables that belong to response spectra analysis cases are available when the corre-
sponding dynamic load case (DLC) is chosen in the drop-downmenu. Tables 5.11 to 5.16 belong to
this type of dynamic load cases. The response spectrum analysis belongs to themodule RF-DYNAM
Pro - Forced Vibrations. The input data required for a response spectrum analysis is discussed in
Section 2.5 and Section 2.9.

You can switch among the results in the separate excitation directions X, Y and Z as well as among
the combined results (SRSS or 100% / 30% rule) with the drop-down menu shown on the left. The
tabulated results and also the graphic in the work window of RFEM will be updated according to
your choice.

Only in the dynamic Tables 5.11 through 5.16, you get results of both themodal combinations and
the directional combinations. The exported RCs in RFEM contain only the final result combinations,
however, i.e. after the directional components have been combined.

When you have selected the export of result combinations as discussed in Section 2.9.5, the RCs
are available in the drop-down list in the toolbar in RFEM shown on the left. You have also access
to the RCs in the Data navigator using Load Cases and Combinations→ Result Combinations
or from the Edit Load Cases and Combinations dialogue box that can be accessed with the
button.



4 Results

©DLUBAL SOFTWARE 2020

61

4
4.2.1 Support Forces

The nodal support forces are provided in Table 5.11 which is shown in Figure 4.8. Similarly, the
line support forces are listed in Table 5.12. In those tables, the maximum and minimum support
forces are listed with the corresponding values.

Figure 4.8: Table 5.11 Nodes - Support forceswith maximum and minimum results in directions X, Y, and Z

4.2.2 Nodal Deformations

The nodal deformations are provided in Table 5.13 as shown in Figure 4.9. The maximum and
minimum values are listed for every node.

Figure 4.9: Table 5.13 Nodes - Deformationswith maximum and minimum displacements and rotations

4.2.3 Pseudo Velocities and Accelerations

Additionally to the standard results, pseudo velocities and accelerations are provided in Table 5.14
shown in Figure 4.10 and Table 5.15 shown in Figure 4.11. The maximum and minimum values
are listed for every node.
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Figure 4.10: Table 5.14 Nodes - Pseudo-Velocities with maximum and minimum velocities and angular
velocities

Figure 4.11: Table 5.15Nodes - Pseudo-Accelerationswithmaximumandminimumaccelerations and angular
accelerations

Pseudo velocities and accelerations are not included in the load cases or result combinations that
have been exported to the main program RFEM.

4.2.4 Member Internal Forces

The internal forces of members are listed in Table 5.16 as shown in Figure 4.12. The maximum and
minimum internal forces are provided with all corresponding values.

Figure 4.12: Table 5.16Members - Internal Forceswith maximum and minimum results N, Vy, VZ,MX,MY,MZ
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4.2.5 Surface Internal Forces

Table 5.17 provides the surface internal forces as shown in Figure 4.13. The maximum andmini-
mum values together with the coordinates of the FE-Nodes are provided in that table.

Figure 4.13: Table 5.17 Surfaces - Internal Forceswith maximum andminimum resultsmx,my,mxy, vx, vy, nx,
ny, and nxy

4.2.6 Surface Basic Stresses and Strains

The basic stresses and strains of surfaces are listed in Table 5.18 and Table 5.19. The basic stresses
are shown in Figure 4.14.

Figure 4.14: Table 5.18 Surfaces - Basic Stresseswith maximum and minimum normal and shear stresses

4.2.7 Exported Result Combinations

When performing a response spectrum in the add-onmodule RF-DYNAMPro - Forced Vibrations,
result combinations are produced only from the finally combined results. Two steps of combi-
nations are undertaken internally within RF-DYNAM Pro to achieve those results: (1) The modal
responses are combined with the SRSS or CQC rule, and (2) the directional results are combined
either with the SRSS or with the 100% / 30% (40%) rule. Those final RCs will be exported.

The list of generated result combinations can be found in the Edit Load Cases and Combinations
dialogue box displayed in Figure 4.15.
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Figure 4.15: Dialogue box Edit Load Cases and Combinations with exported RCs from response spectrum
analysis, containing only result combinations of directional combination

The exported RCs cannot be modified, and the calculation parameters cannot be changed.

4.2.8 Export to Excel or CSV

You can export all results tables that have been discussed in this section to MS Excel or save them
in the CSV format using the File → Export option. The list of results tables is shown in Figure 4.16.

Figure 4.16: Results tables to export for dynamic load cases (DLC) with response spectrum analysis

The Export envelopes only option is selected by default. Only the results tables that belong to the
Dynamic Envelopes (i.e. X100% / Y30% / Z30%) will be exported. When you clear this check box,
the results tables that belong to the single directions will also be exported.

4.3 Dynamic Load Cases - Time History Analysis

The results tables that belong to Time History Analysis Cases are available when the corresponding
dynamic load case (DLC) is chosen in the drop-down menu. Tables 5.18 to 5.26 belong to this
type of dynamic load cases. The linear time history analysis belongs to the module RF-DYNAM Pro -
Forced Vibrations, the nonlinear time history analysis to the module RF-DYNAMPro - Nonlinear Time
History.

The input data required for a time history analysis is discussed in Section 2.10. The definition of
accelerograms is described in Section 2.6, the definition of time diagrams in Section 2.7.

Results are available separately for each time step. The Dynamic envelope is an envelope of results
providing the maximum and minimum results of all time steps. You can switch among the results
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using the drop-downmenu shown on the left. The tabulated results and also the graphic in the
work window of RFEM will be updated according to your choice.

The results can also be displayed versus time in the Time CourseMonitorwhich is accessible with
the button in the menu bar of the table or in the panel. You can activate the animation in
the main graphic by using the button in the menu bar of RFEM or in the panel. When you
have the Time Course Monitor open at the same time, the cursor moves through the plot while the
animation is running.

When you have selected the export of load cases and/or result combinations as discussed in Sec-
tion 2.10.7, the LCs and RCs are available in the drop-down list in the toolbar in RFEM shown on
the left. You have also access to the LCs in the Data navigator using Load Cases and Combina-
tions→ Load Cases or similarly for the RCs using Result Combinations. Load cases and result
combinations are also accessible in the Edit Load Cases and Combinations dialogue box.

Load cases exported from a time history analysis are special: They do not contain loads, only the
results of the specific time step.

4.3.1 Support Forces

The nodal support forces are provided in Table 5.18 which is shown in Figure 4.17. Similarly, the
line support forces are listed in Table 5.19. The maximum values are provided when the Dynamic
envelope has been selected.

Figure 4.17: Table 5.18 Nodes - Support Forceswith results in directions X, Y, and Z

4.3.2 Nodal Deformations

The nodal deformations are provided in Table 5.20 as shown in Figure 4.18. The maximum values
are provided when the Dynamic envelope has been selected.

Figure 4.18: Table 5.20 Nodes - Deformationswith displacements uX, uY, uZ and rotations 𝜑X, 𝜑Y, 𝜑Z

4.3.3 Member Internal Forces

The internal forces of members are listed in Table 5.21 as shown in Figure 4.19. The maximum
values are provided when the Dynamic envelope has been selected.
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Figure 4.19: Table 5.21 Members - Internal Forces with normal forces N, shear forces Vy and VZ, as well as
momentsMX,MY, andMZ

4.3.4 Surface Results

Table 5.22 provides the surface internal forces as shown in Figure 4.20.

Figure 4.20: Table 5.22 Surfaces - Internal Forceswith resultsmx,my,mxy, vx, vy, nx, ny, and nxy

The stresses of the surfaces are listed in Table 5.23 as shown in Figure 4.21.

Figure 4.21: Table 5.23 Surfaces - Basic Stresseswith normal and shear stresses

4.3.5 Nodal Accelerations and Velocities

Additionally to the standard results, nodal accelerations and velocities are provided in Table 5.25
shown in Figure 4.22 and Table 5.26 shown in Figure 4.23. Those results are available for each time
step. The dynamic envelope is provided, too.
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Figure 4.22: Table 5.25 Nodes - Accelerationswith accelerations üX, üY, üZ and rotations 𝜑̈X , 𝜑̈Y , 𝜑̈Z

Figure 4.23: Table 5.26 Nodes - Velocitieswith velocities u̇X, u̇Y, u̇Z and rotations 𝜑̇X , 𝜑̇Y , 𝜑̇Z

Nodal accelerations and velocities are not included in the load cases or result combinations that
have been exported to the main program RFEM.

4.3.6 Time Course Monitor

All results that are listed in the tables discussed above – apart from the surface stresses – can
be displayed versus the time with the Time Course Monitor. It represents the most important
postprocessing tool of a time history analysis. The Time CourseMonitor is illustrated in Figure 4.24.

This graphic is available with the [Time CourseMonitor] button. It can be found in the table toolbar
and in the Factors tab of the panel.

Figure 4.24: Time Course Monitor to display results versus time – here the displacements uX of three nodes
are displayed, showing the maximum and minimum values.

You can choose between Nodes,Members, Surfaces, and Support Nodes in the drop-downmenu as
seen on the left. Depending on this choice, different results are available as shown in Figure 4.25.



4 Results

©DLUBAL SOFTWARE 2020

68

4

Figure 4.25: Available results for (a) nodes, (b) members, (c) surfaces, and (d) support nodes

For members and surfaces, you have to select the member or surface number from the list.

Depending on the choice of objects, either a list of finite element mesh points (see Figure 4.24) or
a list of distances on members (see Figure 4.26) is available. A multiple choice of listed points or
positions is possible by using the [Ctrl] or [Shift] key.

The legend in the graphic is set automatically; the axis labels and axis scales are also adjusted
depending on the selection. The minimum and maximum results with the corresponding time
steps are provided. You can use themouse wheel to zoom into the graph. Values will be displayed
on the pointer when it is moved along the graph.

Theworkwindowof RFEM, the tables and the TimeCourseMonitor are interacting: When you select
the row of a specific member in a table or a node in the graphic, the settings in the Time Course
Monitorwill be adjusted. You only have to choose the result that is to be displayed (Figure 4.25).

The root mean square (RMS) value of any results up to a specific time can be displayed if the check
box shown on the left is selected and a time is defined. The RMS value is calculated as follows:

RRMS = √1
n

(R2
1 + R2

2 + … + R2
n ) (4.8)

where Rn are the results of each time stepwith n considered time steps. The RMS value is illustrated
in the Time Course Monitor as shown in Figure 4.26.

Figure 4.26: Time Course Monitorwith RMS value – here the momentMY is displayed versus time, showing
the RMS value up to 1.0 s.

The RMS value is only available when a single graph is plotted. If you overlay the results of several
nodes, the RMS check box is not available.
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With the [Print] button you canprint the TimeCourseMonitor to theprintout report. In the following
dialogue box, you can define the header of this graphic to be used in the report.

When you right-click on the Time Course Monitor, you have three options: (1) You can access the
Numeric Values in tabular view. The time steps are listed with all results displayed in the graphics.
An example is shown in Figure 4.27. The values as tabulated can be exported to Excel via the
button. (2) You can save the Time Course Monitor as Picture, and (3) you can access the Settings of
the graph. The Settings dialogue box of the Time Course Monitor is shown in Figure 4.28.

Figure 4.27: Numeric values of plot displayed in Time Course Monitor

Figure 4.28: Settings of Time Course Monitor

4.3.7 Exported Load Cases

When you have performed a time history analysis in RF-DYNAM Pro - Forced Vibrations, you can
export the results of single time steps to load cases (LC). The exported load cases for single time
steps are listed in the Edit Load Cases and Combinations dialogue box shown in Figure 4.29.
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Figure 4.29: Dialogue box Edit Load Cases and Combinationswith exported load cases LC from a time history
analysis containing the results of single time steps

The exported LCs cannot be modified and the calculation parameters cannot be changed. Those
load cases do not contain loads, they contain the results of the specific time step. They cannot be
used in load combinations (CO), only in result combinations (RC).

4.3.8 Exported Result Combinations

When you have performed a time history analysis in RF-DYNAM Pro - Forced Vibrations, you can
export an envelope of results over all time steps to a result combination (RRC). The Edit Load Cases
and Combinations dialogue box is shown in Figure 4.30.

Figure 4.30: Dialoguebox Edit LoadCasesandCombinationswith exported result combinationRC containing
the result envelope over all time steps from a time history analysis

The exported RCs cannot be modified and the calculation parameters cannot be changed.
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4.3.9 Export to Excel or CSV

You can export all results tables that have been discussed in this section to MS Excel or save them
in the CSV format using the File → Export option. The list of results tables is shown in Figure 4.31.

Figure 4.31: Results tables to export for dynamic load cases (DLC) with time history analysis

The Export envelopes only option is selected by default. Only the results tables that belong to the
Dynamic Envelopeswill be exported. When you clear this check box, the results tables of all time
steps will be exported. Note that exporting can take considerably long when you export all time
steps.
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4.4 Dynamic Load Cases - Equivalent Load Analysis

The results tables that belong to equivalent load analysis cases are available when the correspond-
ing dynamic load case (DLC) is chosen in the drop-downmenu. Tables 5.8 to 5.10 belong to this
type of dynamic load cases. The equivalent load analysis belongs to the module RF-DYNAM Pro -
Equivalent Loads. The input data required for an equivalent load analysis is discussed in Section 2.5
and Section 2.11.

You can switch among the tables showing the equivalent loads for all eigenvalues of the system,
or separately for eachMode Shape.

4.4.1 Equivalent Loads

For an equivalent load analysis, only the equivalent loads are calculated by RF-DYNAM Pro. The
actual calculation has to be performed in the main program RFEM.

The equivalent loads FX, FY, and FZ are calculated separately for each excitation direction of the
response spectra, and separately for each mode shape of the system, as follows:
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where

𝛤 Participation factors inX, Y, and Z-direction as defined in Equation 4.4 using amodalmass
ofMi = 1 kg

u Displacement values in X, Y, and Z-direction of the mode shape scaled so that
Mi = uT

i Mui = 1 kg
Sa(T) Acceleration read from the response spectra diagram using the natural period T of the

considered eigenvalue
M Mass in the direction X, Y, and Z at the considered FE-node

With the formulas provided in Equation 4.9, the equivalent loads resulting from a response spec-
trum in X-direction are calculated. Accordingly, Equation 4.10 describes the loads resulting from a
response spectrum in Y-direction, and Equation 4.11 the loads resulting from a response spectrum
in Z-direction.

Those equivalent static forces exist at each FE-node within the structure, provided that the mass
M or the mode shape u is not 0 at this point.

The results tables for the equivalent load analysis are separated into the three excitation directions.
Table 5.8 gives the resulting equivalent loads for response spectra acting in X-direction, Table 5.9
those for response spectra acting in Y-direction, and Table 5.10 those for response spectra acting
in Z-direction. Table 5.9 is illustrated in Figure 4.32.
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When the equivalent loads are listed for only one eigenvalue of the system, the sum of equivalent
loads is listed at the bottom of Tables 5.8, 5.9, and 5.10. It is represented by the formulas

∑ FX,i = ∣∑(FX,i)∣ (4.12)

∑ FY,i = ∣∑(FY,i)∣ (4.13)

∑ FY,i = ∣∑(FY,i)∣ (4.14)

where i is the number of the considered eigenvalue. This sum of forces of each eigenvalue is the
base shear force.

When the equivalent loads are listed for All mode shapes of the system in one table, the overall
sum of the base shear forces from each eigenvalue is listed at the bottom of Tables 5.8, 5.9, and
5.10.

Table 5.9 is illustrated in Figure 4.32, listing the equivalent loads that belong toMode shape 1 and
the base shear forces resulting from the excitation in Y-direction. Note that also the LC numbers
are provided to which the equivalent loads are exported.

Figure 4.32: Table 5.9 Equivalent Loads (Y-excitations) of mode shape 1 resulting from response spectrum in
Y-direction

4.4.2 Torsional Moments

Accidental torsional actions can be considered as described in Section 2.11.2 to account for un-
certainties in the location of masses. The centre of mass is considered to be displaced by the
accidental eccentricities eX and eY. The torsional moments are calculated as follows:

MZ = |FX ⋅ eY| + |FY ⋅ eX| (4.15)

where MZ is the torsional moment and FX and FY are the equivalent loads on each FE node as
defined in Equations 4.9, 4.10, and 4.11. The torsional momentsMZ are considered in both positive
and negative directions.

4.4.3 Exported Load Cases

The equivalent loads as listed in the dynamic results tables are exported in load cases of the main
program RFEM. This is done separately for each eigenvalue and for each excitation direction. The
list of generated load cases can be viewed in the Edit Load Cases and Combinations dialogue box
as shown in Figure 4.33. Here, the accidental torsional actions (described in Section 2.11.2) are
activated and two load cases for each mode and direction are generated. The torsional moments
are considered in the positive and negative directions.
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Figure 4.33: Dialogue box Edit Load Cases and Combinationswith exported load cases LC from equivalent
load analysis showing two load cases for each mode and direction due to accidental torsion

The Angular frequency 𝜔 and Lehr's damping value D are also exported as LC properties from
RF-DYNAM Pro to enable the CQCmodal combination. If the SRSS rule was set in RF-DYNAM Pro,
the exported damping value D = 0.

You can adjust the Calculation Parameters to your needs in the second sub-tab. Those parameters
are shown in Figure 4.34.

Figure 4.34: Calculation parameters of exported load cases from equivalent load analysis
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Changing the calculation parameters may be necessary when

• the structure has a dominant mode shape and the analysis shall consider the P-Δ effect,

• stiffness modifications were applied in the natural vibration cases (see Section 2.4.7) and the
LC shall use same modifications for consistency reasons (FAQ 002237 provides an example),

• non-linearities shall be deactivated in the load cases (equivalent loads are based on linearly
calculated eigenvalues and mode shapes, thus LCs should not consider non-linearities).

There might be a conflict of non-linearly calculated load cases and result combinations that are
applied in a dynamic analysis. Please consult the Section 5.5 of the RFEMmanual to understand
the important difference between load combinations (CO) and result combinations (RC). Due to
the quadratic combination rules, only result combinations are possible in a dynamic analysis.

The equivalent loads can be displayed in the work window by pressing the [Show Loads] button.
If more than 5,000 loads are generated, the display is deactivated by default. But in the Details
dialogue box, the number of displayed equivalent loads can be changed (see Section 2.12).

4.4.4 Exported Result Combinations

When performing an equivalent load analysis in the add-on module RF-DYNAM Pro - Equivalent
Loads, result combinations are produced in two steps: (1) Themodal responses are combinedwith
the SRSS or CQC rule and are exported in result combinations (RC) separately for each excitation
direction. (2) The directional results are combined either with the SRSS or with the 100% / 30%
rule and the final result combinations (RC) are exported as well.

A list of generated result combinations can be found in the Edit Load Cases and Combinations
dialogue box displayed in Figure 4.35. In this figure, the modal combination for the Z-direction is
shown.

Figure 4.35: Dialogue box Edit Load Cases and Combinationswith exported result combinations from the
equivalent load analysis showing RC for modal combination in Z-direction

Dialoguebox section Loading inResultCombinationRC102 in Figure 4.35 lists the load cases (LC) that
contain the equivalent loads relevant in the considered excitation direction. Here, the accidental
torsional actions (described in Section 2.11.2) are activated, so two load cases for each mode and
direction exist. They are combined with the OR criterion before the SRSS or CQC rule is applied.

www.dlubal.com/en/support-and-learning/support/faq/002237
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The load cases are combined with the CQC rule according to the equivalent linear combination
(see Figure 4.36). For the Extreme value signs, the LC of the dominant mode shape is set in the
drop-downmenu. Those calculation parameters are automatically generated by RF-DYNAM Pro
depending on the settings you have made in the add-on module. The calculation parameters of
the result combination (RC) are shown in Figure 4.36.

Figure 4.36: Calculationparameters of exportedRC formodal combinationwithCQC rule as equivalent linear
combination applied and signs of LC corresponding to dominantmode shape set automatically

The calculation parameters of the result combinations can be changed in RFEM independently of
the settings in RF-DYNAM Pro.

In the second step of combination, the responses resulting from different excitation directions
are combined. One of the final result combinations (RC) is selected in Figure 4.37. Note the factors
1.00 and 0.30 that have been applied to account for the 100% / 30% rule.

Figure 4.37: Dialogue box Edit Load Cases and Combinationswith exported result combinations from the
equivalent load analysis showing RC of directional combination with 100% / 30% rule
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4.4.5 Export to Excel or CSV

You can export all results tables that have been discussed in this section to MS Excel or save them
in the CSV format using the File → Export option. The list of results tables is shown in Figure 4.38.

Figure 4.38: Results tables to export for dynamic load cases (DLC) with equivalent load analysis

The Export envelopes only option is selected by default. Only the results tables containing the
equivalent loads of all mode shapes will be exported. When you clear this check box, the tables
that belong to each single mode shape will be exported as well.

4.5 Automatic Combinations in RFEM
In RFEM, you have the option to create load combinations (CO) and result combinations (RC)
automatically. This is described in Chapter 5 of the RFEMmanual.

Note that those automatic combinations are not yet supported for the load cases and result
combinations imported from RF-DYNAM Pro. You can still use the automatic combination feature
for all the other load cases that you want to combine (i.e of action self-weight or imposed loads).

In RFEM, you activate the automatic combination feature in theGeneral Data as seen in Figure 4.39.

Figure 4.39: Activation of automatic combination feature in General Data dialogue box of RFEM
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When you have activated the automatic combinations before you calculate any of the RF-DYNAM
Pro cases, the LCs and RCs imported from RF-DYNAM Pro will not be included in any of the Actions,
i.e. no action of the Earthquake category will exist. Consequently, the dynamic LCs and RCs will
not influence the load and result combinations that are created automatically.

Figure 4.40 shows the Action tab of the Edit Load Cases and Combination dialogue box. The LCs
imported from RF-DYNAM Pro - Forced Vibrations are not included in the Permanent action A1,
although the Permanent action category is allocated.

Figure 4.40: Actions tab of Edit Load Cases and Combinations dialogue box when automatic combinations
were activated before the RF-DYNAM Pro calculation – RF-DYNAM Pro results are available, but
imported LCs are not included in Existing Actions and no action of type Earthquake is available

When you switch on the Create combinations automatically option after you have calculated the
results in RF-DYNAM Pro and exported the LCs and RCs, make sure you keep the user-defined
result combinations as indicated in Figure 4.41.

Figure 4.41: RFEMwarning when activating automatic combination feature – make sure to keep existing
RCs if RF-DYNAM Pro results are available

In this order, the Actionswill take the LCs from RF-DYNAM Pro into account, and an action of the
Earthquake category will be generated. This is illustrated in Figure 4.42.
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Figure 4.42: Actions tab of Edit Load Cases and Combinations dialogue box when automatic combinations
were activated after the RF-DYNAMPro calculation – Earthquake action existswith LCs imported
from RF-DYNAM Pro included

Nevertheless, this does not influence the automatic combinations, which means that no Action
Combinations, Load Combinations or Result Combinationswill be created for the design situation
Earthquake. Load cases that have been imported from a time history analysis are included in load
combinations, though, but as they do not contain any loads (they contain only results of a specific
time step as described in Section 4.3), they do not have an influence on the results.

The result combination for the design situation Earthquakemust be defined manually. Creating
Load Combinations is not sufficient, due to the quadratic combination rules that are requested
for a response spectrum analysis. For the time history analysis, Load Combinations are not suited
either because the exported LCs are only for single time steps and do not contain loads.

In EN 1990 [4] Section 6.4.3.4, Equation (6.12) provides the combination expression for the design
situation Earthquake as follows:

Ed = ∑
j≥1

Gk,j “+” P “+” AEd “+” ∑ 𝛹2,iQk,i (4.16)

where AEd shall be the resulting RCs from RF-DYNAM Pro. The combination factors 𝛹2 are listed in
EN 1990 [4] Table A.1.1.

An example how this is done for a response spectrum analysis can be found in Section 5.1.
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4.6 Printout Report
You can create a printout report containing the dynamic results. Detailed information on the
printout report can be found in Chapter 10 of the RFEMmanual.

When dynamic results are available, you can include the Input Data and the Natural Vibration Case
data in the Printout Report Selection dialogue box as shown in Figure 4.43 and Figure 4.44.

Figure 4.43: Dialogue box Printout Report Selectionwith Input Data available for RF-DYNAM Pro case

TheModeShapes table that represent the selection ofmode shapes and corresponding values read
from the response spectrum can be included by selecting Table 1.8.2.2 and/or 1.8.5.2. This table
was discussed in Section 2.9.7 and is relevant for a response spectrum analysis and an equivalent
load analysis.

Figure 4.44: Dialogue box Printout Report Selectionwith Natural Vibration Case data available

Each of the entries can be selected for all cases (NVCs or DLCs). When you clear the All check box,
you can select specific cases.
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All other RF-DYNAM Pro results are available in exported load cases or result combinations. The
printout report for those results can be adjusted as described in Chapter 10 of the RFEMmanual.

4.7 Units and Decimal Places

You can access the Units and Decimal Places dialogue box with the button shown on the left.
The dialogue box with the Results tab of the RF-DYNAM Pro add-on module open is shown in
Figure 4.45.

Figure 4.45: Dialogue box Units and Decimal Places showing settings of RF-DYNAM Pro Results data

Select the add-on module RF-DYNAM Pro in the list of modules. In the Results tab, you can choose
the units from the drop-downmenus and adjust the decimal places.

As the RF-DYNAM Pro results are embedded in the main program RFEM, most of the result values
can be adjusted in the RFEM list of units and decimal places as shown in Figure 4.46.

Figure 4.46: Dialogue box Units and Decimal Places showing settings for RFEM Results
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5 Examples
An example how to perform a natural vibration analysis and a multi-modal response spectra
analysis using the module RF-DYNAM Pro - Equivalent Loads is shown in the webinar Natural
Frequencies and Equivalent Static Force Analysis with RFEM.

The simulation of walking and running across a pedestrian bridge demonstrating a complex time
history analysis using the module RF-DYNAM Pro - Forced Vibrations is presented in thewebinar
Time History Analysis in RF-/DYNAM Pro - Walking and Running Across Pedestrian Bridge. It is
shown how time diagrams can be defined via functions employing parameters that are defined in
the main program RFEM. Also used are multiple load-time diagram sets.

In thewebinar Nonlinear Time History Analysis – Machine-Induced Vibrations, induced vibrations
on a structurewith nonlinear tensionmembers are analysedwith the nonlinear timehistory solvers.

More examples are available on our website that demonstrate the accuracy of the dynamic mod-
ules. The verification example of a Cantilever Beam (SDOF) with Periodic Excitation studies the
response of an SDOF system. There the results of RF-DYNAM Pro - Forced Vibrations are compared
with the analytical solution. The verification example of Equivalent Loads compares the equiva-
lent loads calculated by RF-DYNAM Pro - Equivalent Loadswith the analytical solution. Considered
is a 5-DOF system with masses acting in X-direction.

In the following, Section 5.1 presents an example how an earthquake analysis is performed with
RF-DYNAM Pro - Equivalent Loads. The base shear forces in each floor are evaluated and the storey
drift is calculated. In Section 5.2, machine-induced vibrations are analysed with the module
RF-DYNAM Pro - Forced Vibrations. The case of resonance is studied and the structure is modified
to avoid resonance.

5.1 Earthquake Analysis according to EN 1998-1 CEN
This example presents an earthquake analysis according to EN 1998-1 CEN using the multi-modal
response spectrum analysis by means of the RF-DYNAM Pro - Equivalent Loadsmodule.

5.1.1 System and Load Cases in RFEM

The structural system is shown in Figure 5.1. Thematerials and cross-sections are used as illustrated.

Figure 5.1: Structural system with dimensions, materials and cross-sections

www.dlubal.com/en/support-and-learning/learning/webinars/2015/2015-03-26-natural-frequencies-and-equivalent-static-force-with-rfem
www.dlubal.com/en/support-and-learning/learning/webinars/2015/2015-03-26-natural-frequencies-and-equivalent-static-force-with-rfem
www.dlubal.com/en/support-and-learning/learning/webinars/2015/2015-11-05-time-history-analysis-using-rf-dynam-pro
www.dlubal.com/en/support-and-learning/learning/webinars/2018/2018-03-08-nonlinear-time-history-analysis-machine-induced-vibrations
www.dlubal.com/-/media/543EA0604D9541F5BF38459B149641C5.ashx
www.dlubal.com/-/media/2A3930367D3B43EB90E38509661DA5ED.ashx
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Three load cases are definedwith self-weight and imposed loads. Those load cases are imported as
masses in RF-DYNAM Pro. LC1 defines the self-weight in +Z direction and 0.5 kN/m2. LC2 and LC3
contain 2.5 kN/m2 imposed load acting in the top and bottom level of the building, respectively.

In the General tab of RF-DYNAM Pro, theMass combinations and the Response spectrum analysis
with generation of equivalent loads options are activated as shown in Figure 5.2.

Figure 5.2: General settings for equivalent load analysis

Definition of Masses
Apart from the self-weight, additional masses have to be considered to calculate inertia effects.
This is regulated in EN 1998-1 [1] Section 3.2.4.

∑Gk,j“+” ∑ 𝜓E,i ⋅ Qk,i (5.1)

where Gk,j are the permanent loads and Qk,i any imposed load. 𝜓E,i are the combination factors
for the imposed loads defined as

𝜓E,i = 𝜑 ⋅ 𝜓2,i (5.2)

where𝜓2,i are combination factors regulated in EN 1990 [4] Table A.1.1. Assuming that the building
of this example is of category B (building with offices), 𝜓2 = 0.3. The values of 𝜑 recommended
in EN 1998-1 CEN [1] are 𝜑 = 1.0 for the top level of a building and 𝜑 = 0.5 for all other levels. To
account for the different values of 𝜑, the load cases with imposed loads have been split in LC2 and
LC3.

In RF-DYNAM Pro,Mass Cases are defined to import masses from the load cases of RFEM. The mass
casesMC1 toMC3 are shown in Figure 5.3 and Figure 5.4.



5 Examples

©DLUBAL SOFTWARE 2020

84

5

Figure 5.3: Mass caseMC1 to import self-weight from LC1 (From self-weight of structure option not selected
as self-weight is activated in LC1)

Figure 5.4: Mass caseMC2 to import imposed loads from LC2 acting in top floor

Mass caseMC3 is done in analogy toMC2.

The mass cases are combined in aMass Combination shown in Figure 5.5. The combination factors
𝜓E,i = 𝜑 ⋅ 𝜓2,i are applied in accordance with EN 1998-1 CEN.

Figure 5.5: Mass combinationMCO1 combining masses in compliance with EN 1998-1
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5.1.2 Seismic Analysis in RF-DYNAM Pro

Natural Vibration Analysis
In this example, a three-dimensional natural vibration analysis is performed. Themasses are acting
in the X- and Y-directions. A spatial model is analysed. Simplying the structure to a planar model
(that means that masses are considered to act either in X- or Y-direction) is only allowed for regular
structures in accordance with EN 1998-1 [1] Section 4.2.3.

The Z-direction is neglected in this example as the vertical response spectrum is lower than
2.5 m/s2 (see EN 1998-1 [1] Section 4.3.3.5.2).

The diagonal matrix (translational DOF) concentrates masses in each FE-node; rotational masses
are neglected. This matrix is of sufficient accuracy in this example.

The diagonal matrix (translational and rotational DOFs) would consider the rotational masses. The
consistent matrix would distribute the masses in accordance with finite element shape functions
and therefore increase the accuracy. But depending on the application, this is not always useful as
much more local mode shapes are identified that are not of relevance for the global earthquake
design of the structure.

The Lanczos solver is used for the analysis. This solver is recommended for most structures. The
mode shapes are scaled to the maximum value of 1. Stiffness modifications are not considered.

The settings of natural vibration case NVC1 are illustrated in Figure 5.6.

Figure 5.6: NVC1 defining mass matrix, number of eigenvalues, solver, and scaling of mode shapes

The natural frequencies f, the natural periods T, and the corresponding effective modal mass
factors fme are shown in Figure 5.7. In accordance with EN 1998-1 [1] Section 4.3.3.3, the sum of
the effective modal masses must be greater than 90% of the total seismic load. The first three
eigenvalues are relevant in the Y-direction, and only eigenvalue 28 is relevant in the X-direction.

Figure 5.7: Relevant natural frequencies f [Hz], natural periods T [s] and corresponding effectivemodal mass
factors fme [−]

The listed eigenvalues are considered in the multi-modal response spectrum analysis.
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The dominant mode shape in Y-direction is illustrated in Figure 5.8, the dominant mode shape in
X-direction in Figure 5.9.

Figure 5.8: Dominant mode shape in Y-direction with natural frequency of 1.201 Hz

Figure 5.9: Dominant mode shape in X-direction with natural frequency of 5.28 Hz
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Response Spectrum in Accordance with EN 1998-1 CEN
The horizontal design response spectrum in accordance with EN 1998-1 [1] Section 3.2.2.5 is
defined as:

0 ≤ T ≤ TB : Sd(T) = ag ⋅ S ⋅ [2
3

+ T
TB

⋅ (2.5
q

− 2
3

)] (5.3)

TB ≤ T ≤ TC : Sd(T) = ag ⋅ S ⋅ 2.5
q

(5.4)

TC ≤ T ≤ TD : Sd(T)
⎧{
⎨{⎩

= ag ⋅ S ⋅ 2.5
q

⋅ TC
T

≥ 𝛽 ⋅ ag
(5.5)

TD ≤ T : Sd(T)
⎧{
⎨{⎩

= ag ⋅ S ⋅ 2.5
q

⋅ TCTD
T2

≥ 𝛽 ⋅ ag
(5.6)

where
T : Vibration period in [s]
ag : Design ground acceleration, ag = 𝛾1 ⋅ agR, in [m/s2]
agR : Reference ground acceleration in [m/s2]
𝛾1 : Importance factor

TB : Lower limit of the period of the constant spectral acceleration branch, in [s]
TC : Upper limit of the period of the constant spectral acceleration branch, in [s]
TD : Value defining the beginning of the constant displacement response range of

the spectrum, in [s]
S : Soil factor

Sd(T) : Acceleration values of the design spectrum in [m/s2]
q : Behaviour factor that describes the ductility

𝛽 : Lower bound factor for the horizontal design spectrum

In the example, the reference ground acceleration of agR = 1.0 and importance factor of 𝛾1 = 1.0
(importance category II) are assumed. The parameters S, TB, TC, and TD are chosen in accordance
with ground type C and spectra type 1. The behaviour factor q is kept with 1 on the safe side, and
the lower bound factor 𝛽 = 0.2 is kept as recommended in the standard.

The settings in RF-DYNAM Pro and the resulting horizontal and vertical response spectra are
illustrated in Figure 5.10 and Figure 5.11.
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Figure 5.10: Horizontal design response spectrum in accordance with EN 1998-1 Section 3.2.2.5

Figure 5.11: Vertical design response spectrum in accordance with EN 1998-1 Section 3.2.2.5 – peak value
Sd(T) ≤ 2.5 m/s2 so that vertical direction can be neglected (see EN 1998-1 Section 4.3.3.5.2)
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Response Spectra Analysis with Equivalent Loads
In the RF-DYNAM Pro - Equivalent Loadsmodule, a multi-modal response spectrum analysis is
performed. Then equivalent loads are exported to RFEM separately for each eigenvalue and exci-
tation direction. The settings are done in the Dynamic Load Cases tab as illustrated in Figure 5.12.

Figure 5.12: Dynamic Load Cases tab with settings for Equivalent Force Analysis

The horizontal design response spectrum is applied in the X- and Y-directions. The Z-direction
does not need to be taken into account because the vertical spectrum is less than 2.5 m/s2 (see
EN 1998-1 [1] Section 4.3.3.5.2).

The option to Consider accidental torsional actions is selected to account for uncertainties in the
location of mass. This is described in EN 1998-1 [1] Section 4.3.2. The eccentricities to be applied
are calculated with ei = 0.05 ⋅ Li where Li is the length of the building.

The equivalent loads are exported to Load cases; the number of the first generated load case is set
to 4.

The combination of modal responses is done with the SRSS rule in this example. It can be used
when the eigenvalues are independent. This is the case when the criteria Tj ≤ 0.9 ⋅ Ti is fulfilled
with Tj ≤ Ti (EN 1998-1 [1] Section 4.3.3.3.2). All adjacent natural periods Ti are independent in
this example:

0.718 ≤ 0.9 ⋅ 0.833 = 0.750 (5.7)

0.514 ≤ 0.9 ⋅ 0.718 = 0.646 (5.8)

The SRSS rule is applied in form of the equivalent linear combination. The formula of this combina-
tion rule is provided in Section 2.11.3 in Equation 2.24.

The results of different excitation directions are to be combined according to the 100 / 30% rule.
The directional combinations are regulated in EN 1998-1 [1] Section 4.3.3.5.1.
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In theMode Shapes sub-tab, the results of the assigned natural vibration case NVC1 are listed. Here
specific eigenvalues can be selected that are to be used for the multi-modal response spectrum
analysis. The response spectrum is shown in the graphic below the table. The corresponding
acceleration values of each eigenvalue are listed in the table and are marked in red in the graphic.
The selection of this example is shown in Figure 5.13.

Figure 5.13: Selection of eigenvalues for multi-modal response spectrum analysis

The Load Cases and Result Combination are exported automatically. Due to the accidental torsion,
two load cases for each eigenvalue and excitation direction are exported – one with positive
torsional moments and one with negative torsional moments. The list of exported Load Cases is
shown in Figure 5.14.

Figure 5.14: List of exported Load Cases containing equivalent loads separately for each eigenvalue and
excitation direction – due to accidental torsion two load cases are created for each eigenvalue
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The list of exported Result Combinations is shown in Figure 5.15.

Figure 5.15: List of exported Result Combination for modal combination and directional combination

For themodal combination, load cases (LC) resulting from different eigenvalues but from the same
excitation direction are combined with the SRSS rule. The two LCs with positive and negative
torsional moments are grouped together (alternative combination). The combination scheme is
shown in Figure 5.16.

Figure 5.16: Modal combination scheme to combinemodal response resulting fromexcitation inY-direction

More information on the modal combination when accidental torsion is applied can be found in
the Knowledge Base - 001118.

For the directional combination, the 100% / 30% rule is applied in this example. This is simply
achieved with combination factors as shown in Figure 5.17.

Figure 5.17: Directional combination scheme to combine results from different excitation directions with
100% / 30% rule

RF-DYNAM Pro exports two RCs in this example because two excitation directions are taken into
account. The RC leading to the most unfavourable results is used for the seismic design situation.

www.dlubal.com/en/support-and-learning/support/knowledge-base/001118
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Base Shear Force
There are several options in RF-DYNAM Pro and RFEM to evaluate the base shear force.

• List of equivalent loads in Tables 5.8 and 5.9

The equivalent loads are listed in the results tables 5.8, 5.9, and 5.10 together with the sum of
the equivalent loads. WhenMode Shape 1 is selected, the equivalent loads FY are listed in Table
5.9. The sum is provided as 141.29 kN as shown in Figure 5.18. Note that the equivalent loads
are listed twice because accidental torsions have been activated. Thus, the loads are given for
the cases Torsion + and Torsion -. The real base shear force forMode Shape 1 is FY = 70.65 kN.

Figure 5.18: Sum of equivalent loads ∑ FY resulting from Mode Shape 1, dominant in Y-direction – note
that the equivalent loads are listed twice for Torsion + and Torsion - cases

The sum of equivalent loads resulting fromMode Shape 28 is listed in Table 5.8 (see Figure 5.19).
Again the equivalent loads are listed twice. The real base shear force is FX = 96.83 kN.

Figure 5.19: Sum of equivalent loads ∑ FX resulting fromMode Shape 28, dominant in X-direction

• Information on load cases in Table 4.0

In Table 4.0 Results - Summary, the sums of all loads and the sums of support forces are listed.
For the dominant eigenvalue in Y-direction, which is exported to LC4 and LC5 respectively, the
base shear force is ∑ FY = 70.65 kN (see Figure 5.20).

Figure 5.20: Sum of loads ∑ FY for LC 4 resulting fromMode Shape 1, dominant in Y-direction

For the dominant eigenvalue in X-direction, which is exported to LC10 and LC11 respectively,
the base shear force is ∑ FX = 96.83 kN (see Figure 5.21).
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Figure 5.21: Sum of loads ∑ FX for LC 10 resulting fromMode Shape 28, dominant in X-direction

• Evaluation with Result Beam

A result beam can be placed anywhere in the model as a virtual member. It integrates the
results over the objects that you define. For further details, see Chapter 4.17 of the RFEM
manual and the Knowledge Base - 000704. The result beam is very useful to evaluate the base
shear forces separately for each storey of the building. In this example, the result beam is
placed outside the structural system. It includes all objects as shown in Figure 5.22.

Figure 5.22: Structural system with result beam placed outside of model, including all objects

In LC4, the shear forces Vy in the result beam provide the base shear forces resulting fromMode
shape 1 in Y-direction. In LC10, the shear forces Vz in the result beam provide the base shear
forces resulting fromMode shape 28 in X-direction. Both are displayed in Figure 5.23 and the
results are summarised in Table 5.1.

Figure 5.23: Base shear forces of result beam for LC4 (Vy resulting frommode shape 1 in Y-direction) and
LC10 (Vz resulting frommode shape 28 in X-direction)

www.dlubal.com/en/support-and-learning/support/knowledge-base/000704
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The base shear forces of the result combinations (RC) can also be evaluated, which gives the
base shear forces of the combined results. RC5 contains the results of the SRSS rule in the
Y-direction, RC4 the combined results in the X-direction.

The shear forces in the result beam are shown in Figure 5.24.

Figure 5.24: Base shear forces showing combined dynamic results of result beam for RC5 (Vy in Y-direction)
and RC4 (Vz in X-direction)

The base shear forces of the single storeys are listed in Table 5.1.

Level Z = −8 m Level Z = −4 m ∑F

LC4: Mode Shape 1 - Y-Direction 39.76 kN 30.89 kN 70.65 kN

LC10: Mode Shape 28 - X-Direction 60.84 kN 35.99 kN 96.83 kN

RC5: SRSS - Y-Direction 39.86 kN 30.94 kN 70.80 kN

RC4: SRSS - X-Direction 60.84 kN 35.99 kN 96.83 kN

Table 5.1: Base shear forces of single storeys resulting from dominant eigenvalues and modal combination
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Storey Drift
Maximal displacements can be used to evaluate the inter-storey drift. In accordance with EN
1998-1 [1] Section 4.4.2.2, the influence of the second-order effects (P-Δ effect) can be neglected
when the inter-storey drift sensitivity coefficient 𝜃 is small enough. It is defined as follows:

𝜃 = Ptot ⋅ dr
Vtot ⋅ ℎ

≤ 0.1 (5.9)

where
𝜃 : Inter-storey drift sensitivity coefficient

Ptot : Total gravity load at and above the storey considered

dr : Design inter-storey drift, i.e. difference of the lateral displacements ds at the top
and bottom of the storey under consideration

Vtot : Total seismic storey shear

h : Inter-storey height

To evaluate the total gravity load at and above the storey considered, themasses on each FE-node
need to be analysed.

Themasses on each FE-node togetherwith the coordinates of those FE-nodes are listed in Table 5.6.
That table can be exported to Excel and filter options can be used to summarise the masses for
each storey. For the roof level Z = −8 m, the massmZ=−8 m = 19,588.21 kg has to be considered.
The mass at level Z = −4 m consists of the bottom storey, which is mbottom = 17,927.17 kg,
and the mass at the roof level. Altogether the mass to be considered at the level Z = −4 m is
mZ=−4 m = 37,515.38 kg. For the level Z = 0 m, the sum of masses ismZ=0 m = 813.32 kg; those
are not considered as this is the level of support.

The storey shear forceswere discussed in the last paragraph. The loads are summarised in Table 5.1.
The height of the storeys is h = 4 m.

The global deformations uY in RC5 (earthquake in Y-direction) are illustrated in Figure 5.25.

Figure 5.25: Global deformations uY resulting from earthquake excitation in Y-direction (RC5)
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The design inter-storey drift for the top level is dr,top = 51.4 − 36.0 = 15.4 mm. For the bottom
level, dr,bottom = 36.0 mm. The inter-storey drift sensitivity coefficient for the top level can be
calculated with

𝜃top = 19,588.21/100 ⋅ 15.4/1,000
39.86 ⋅ 4

= 0.02 (5.10)

and for the bottom level with

𝜃bottom = 37,515.38/100 ⋅ 36.0/1,000
30.94 ⋅ 4

= 0.11. (5.11)

The limit of 0.1 is exceeded in the bottom level.

The global deformations uX in RC4 (earthquake in X-direction) are illustrated in Figure 5.26.

Figure 5.26: Global deformations uX resulting from earthquake excitation in X-direction (RC4)

The design inter-storey drift for the top level is dr,top = 3.2 − 1.8 = 1.4 mm. For the bottom level,
dr,bottom = 1.8 mm. The inter-storey drift sensitivity coefficient for the top level can be calculated
with

𝜃top = 19,588.21/100 ⋅ 1.4/1,000
60.84 ⋅ 4

= 1.13 × 10−3 (5.12)

and for the bottom level with

𝜃bottom = 37,515.38/100 ⋅ 1.8/1,000
35.99 ⋅ 4

= 4.69 × 10−3. (5.13)

In the X-direction of the building, the limit of 0.1 is not exceeded.

In this example the inter-storey drift sensitivity coefficient 𝜃 according to Equation 5.9 in the
bottom level in Y-direction is slightly exceeded. In accordancewith EN 1998-1 [1] Section 4.4.2.2 (3),
second-order effects can be approximately taken into account by multiplying the seismic action
effects with a factor of 1/(1 − 𝜃), provided that the sensitivity coefficient 𝜃 is smaller than 0.2.
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Second-Order Effects

• Approximate consideration of P-Δ effects with factor 1/(1 - 𝜃)

To increase results in order to approximately consider P-Δ effects, Factor 1/(1−0.11) = 1.124
is used in the dynamic load caseDLC2 as shown in Figure 5.27. Only the Y-direction is increased
by this factor.

Figure 5.27: Factor 1/(1 − 𝜃) to approximately consider P-Δ effects

• Geometric stiffness matrix to consider P-Δ effects

When youhave larger storey drifts andneed to consider the P-Δ effects in amore exactmanner,
you can activate the influence of axial forces in RF-DYNAM Pro. This takes the geometric
stiffness matrix into account. Frequencies and equivalent loads will then be calculated with a
modified stiffness matrix. The influence of axial forces can be activated in the Natural Vibration
Cases tab as shown in Figure 5.28.

Figure 5.28: Consideration of axial forces in natural vibration case to consider geometric stiffness matrix
with axial forces taken from CO2

Load combination CO2 combines the load cases with self-weight and imposed loads in accor-
dance with the Design Situation Earthquake. The combination factors 𝛹2 are in accordance
with EN 1990 [4] Table A.1.1. This CO2 is used for the modification of the stiffness matrix, as
this is the design combination which is relevant in an event of an earthquake.
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The settings of the natural vibration case (NVC) influence the natural frequencies of the system.
The NVC has to be assigned to the dynamic load case (DLC) so that the modified frequencies
are used for the calculation of equivalent loads. The settings of DLC3 are shown in Figure 5.29.

Figure 5.29: Modified stiffness matrix assigned to DLC – the frequencies are slightly changed, as well as the
corresponding acceleration values Sa read from the response spectrum (cf Figure 5.13)

The equivalent loads are calculated with those modified frequencies and are then exported to
the main program RFEM. The stiffness modifications are not automatically applied in the load
cases. You need to consider themodified stiffness matrix also to calculate your final results like
deformations and internal forces. The settings as shown in Figure 5.30 have to set manually.
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Figure 5.30: Stiffness modification of load cases exported from DLC3 – the geometric stiffness matrix has to
be taken into account for the calculation of those load cases

Result Combination for Design Situation Earthquake
The two result combinations exported from RF-DYNAM Pro (RC6: 100% X, 30% Y and RC7: 30% X,
100% Y) are combined with OR. The disadvantageous RC is used as AEd in the design combination
for earthquake. This is defined in EN 1990 [4] Section 6.4.3.4, Equation (6.12).

Ed = ∑
j≥1

Gk,j “+” P “+” AEd “+” ∑ 𝛹2,iQk,i (5.14)

The combination factors 𝛹2 are listed in EN1990 [21] Table A.1.1. Note that those combination
factors have already been used in the mass combinations (MCO).

The combination for the seismic design situation has to be defined manually in RFEM. This can be
done using load cases (LC) or the priorly defined load combination CO2. Both options are shown
in Figure 5.31.

Figure 5.31: Seismic design situation in accordance with EN 1990: a) combination with load cases and b)
combinationwith load combination CO2 defined earlier using the same combination factors𝛹2



5 Examples

©DLUBAL SOFTWARE 2020

100

5
The use of a load combination (CO) is recommended when nonlinearities exist in the model, or
when second-order effects have to be considered.

The resulting momentMY and the support forces on selected members of the structure are illus-
trated in Figure 5.32.

Figure 5.32: Results of RC10 for seismic design situation showing moments MY and support forces on
selected members

The internal forces are listed in Table 4.6 as shown in Figure 5.33 for member 6.

Figure 5.33: Table 4.6 Member - Internal Forces showing results of RC10 for seismic design situation for
member 6 at node 5

The modal combination rule was applied in form of the equivalent linear combination. The effect
of this can be seen on the corresponding internal forces – they are smaller compared to the
maximum values (displayed bold on the main diagonal) and have varying signs.

The second-order effects were taken into account (1) by an approximate method with the factor
1/(1 − 𝜃) (DLC2 in RF-DYNAM Pro) and (2) by a more exact method with the consideration of the
geometric stiffness matrix (DLC3). For both methods, the final seismic design combination was
built as described above. Figure 5.34 shows a comparison of those internal forces.
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Figure 5.34: Results of seismic design situations considering P-Δ effect by a factor (RC20) and by the geo-
metric stiffness matrix (RC30) showing momentsMY and support forces on selected members

The approximate method using the factor 1/(1 − 𝜃) leads to results on the safe side.

With those result combinations for the seismic design situation, the design of the single construc-
tion elements can be performed, for example with the add-on modules RF-STEEL, RF-STEEL EC3,
or RF-CONCRETE.
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5.2 Machine-Induced Vibrations

In the second example, the dynamic excitation of two rotating machines is analysed by a linear
time history analysis in the add-on module RF-DYNAM Pro - Forced Vibrations.

The steel framework that supports the two machines is excited in resonance first, which means
that the frequency of the structure is the same as the frequency of the excitation. Resulting from
resonance, the systemsexperiences unacceptable largedeformations andaccelerations. Changing
the cross-sections and thus modifiying the natural frequency of the structure is compulsory.

5.2.1 Structural System, Machines, and Load Cases in RFEM

Figure 5.35 shows the structural system and the applied materials and cross-sections.

Figure 5.35: Structural system with coloured cross-sections and materials and openings where machines
are located

In the openings in the lower and upper levels, twomachines are located. Themachines themselves
are not modelled – they are represented by their dead loads and the centrifugal forces that they
produce.

The self-weight of the steel frame in the +Z-direction and an additional surface load of 0.5 kN/m2

are defined in LC1. This load case will be imported as mass in RF-DYNAM Pro.

Each of the machines has a self-weight ofm = 1.84 t. This dead load acts as line loads on the
adjacent members. It is defined in LC2 as illustrated in Figure 5.36.
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Figure 5.36: Self-weight of machines, defined as line loads on members around openings

The mass of the rotor mR = 0.5 t rotates with 310 rpm with an eccentricity of e = 19 mm.
This movement is illustrated in Figure 5.37. The centrifugal force Fr acts perpendicularly to the
rotational movement.

Figure 5.37: Rotation of rotor massmR within machine and resulting centrifugal force Fr

The excitation frequency of the machine can be calculated with:

𝜔e = 2𝜋 ⋅ 310/60 s = 32.463 rad/s (5.15)

Wewill define time diagrams later in RF-DYNAM Pro when the excitation frequency 𝜔e is entered.

The value of the centrifugal force is defined with:

Fr = 𝜔 2
e ⋅ e ⋅ mR = 10.01 kN (5.16)
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The modelling in RFEM is simplified by defining only the horizontal and vertical centrifugal forces,
which is of sufficient accuracy. The horizontal component is delayed in time and defined with a
phase shift in the periodical time diagram. This will be considered when the time diagrams are
created in RF-DYNAM Pro.

Again, the centrifugal forces are defined as line loads along the openings. The vertical and hori-
zontal components are arranged in separate load cases. The loads in LC3 and LC4 determine the
size and the position of the time-invariant excitations. Those load cases are shown in Figure 5.38.

Figure 5.38: Centrifugal forces Fr defined as vertical and horizontal line loads along openings in two load
cases

5.2.2 Module RF-DYNAM Pro

In the General tab, the Response spectrum analysis and the Time Diagrams are activated of the
RF-DYNAM Pro - Forced Vibrationsmodule (see Figure 5.39).

Figure 5.39: General tab of RF-DYNAM Pro with Forced Vibrationsmodule and Time Diagrams selected
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Definition of Masses
In this example, only the self-weight of the steel frame and of the machines are of relevance. Thus,
the two relevant load cases LC1 and LC2 are imported as masses into RF-DYNAM Pro. Twomass
cases are defined: MC1 is shown in Figure 5.40,MC2 is defined analogously by importing LC2.

Figure 5.40: Mass caseMC1with self-weight imported from LC1 (option From self-weight of structure cleared
as self-weight has been considered in LC1)

The two mass cases of self-weight are combined in mass combinationMCO1 using factors of 1.0.
This is shown in Figure 5.41.

Figure 5.41: Mass combinationMCO1with combined masses

Natural Vibration Analysis
A time history analysis with the linear implicit Newmark solver does not require any eigenvalues
or mode shapes – the analysis is done via a time step integration scheme. Important for the
accuracy of the solution is the choice of the time step (see next section). Nevertheless, the natural
frequencies are important to understand the behaviour of the structural system. They should be
analysed, therefore, so that possible cases of resonance become clear.

In the natural vibration analysis, a diagonal mass matrix is considered with the masses acting in
the three translational direction X, Y, and Z. The rotational degrees of freedom are taken into
account as well.

The settings of the natural vibration case NVC1 are illustrated in Figure 5.42. There are 10 eigenval-
ues to be calculated.
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Figure 5.42: Natural vibration case NVC1 employing a diagonal mass matrix and with masses acting in all
directions and about all axes

The relevant mode shape 6 in the X-direction with a natural frequency of f = 5.192Hz is illustrated
Figure 5.43. The other eigenvalues are also listed together with the effective modal mass factors.
The dominant eigenvalues are highlighted.

Figure 5.43: Relevantmode shape 6 in X-direction illustrated inworkwindow and all calculated eigenvalues
tabulated with effective modal mass factors
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With its frequency of f = 5.192 Hz, the illustrated mode shape 6 is very close to the excitation
frequency of the machines which is fe = 5.167 Hz.

For time history analyses, the use of the consistent mass matrix is recommended in general. The
consistent matrix distributes the masses more equally over the members, which results in more
local mode shapes to be identified. In this example, however, a diagonal mass matrix is sufficient.

Time Diagrams
The centrifugal forces as defined in LC3 and LC4 shall act over time as harmonic excitations. There-
fore, the definition of time diagrams is required in RF-DYNAM Pro. The excitation frequency is
𝜔 = 32.463 rad/s (see Equation 5.15). For the vertical component, no phase shift is defined in
the periodic time diagram. The horizontal component has to be shifted to express the time delay,
however. This is donewith a phase shift of𝜑 = 𝜋/2. The factor k is set to 1 because themagnitude
of the load was defined in load cases LC3 and LC4.

The definition of the time diagrams is shown in Figure 5.44 and Figure 5.45.

Figure 5.44: Definition of periodic time diagram for vertical component of centrifugal force

Figure 5.45: Definition of periodic time diagram for horizontal component of centrifugal force



5 Examples

©DLUBAL SOFTWARE 2020

108

5
Time History Analysis
In the dynamic load case DLC1, the load cases LC3 and LC4 of RFEM are connected to the time
diagrams TD1 and TD2 that have been defined in RF-DYNAM Pro. The linear implicit Newmark
solver is chosen as the solving algorithm.

In the Time History Analysis tab, the time steps, the maximum time for calculation, and the export
options are defined as shown in Figure 5.46.

Figure 5.46: Settings for linear time history analysis of DLC1with connected load cases and time diagrams,
time steps, and export options

The time step for calculation is set to 𝛥t = 1 ms to achieve the required accuracy of the results.

The relevant frequency of the structure and those of the excitation are about 5.2 Hz. The required
time step can be estimated with the following formula:

𝛥t = 1/(20 f) = 9.6 ms (5.17)

To ensure also exact velocities and acceleration, the time step is chosen even smaller for this
example.

In the Calculation Parameters sub-tab, the acting masses and the mass matrix options are set. This
is shown in Figure 5.47. The Diagonal matrix considering all degrees of freedom is selected.
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Figure 5.47: Settings of DLC1 in Calculation Parameters tab for acting masses and mass matrix

In the Damping sub-tab, the structural damping is defined. The settings for damping used in this
example are shown in Figure 5.48.

Figure 5.48: Settings of DLC1 in Damping tab for Rayleigh coefficients 𝛼 and 𝛽

The linear implicit Newmark solver requires Rayleigh damping coefficients. To convert available
Lehr's damping values to Rayleigh coefficients, the following relation can be used:

Di = 𝛼
2𝜔i

+ 𝛽 𝜔i

2
(5.18)

In this example, the most important eigenvalues in the X- and Y-directions shall be damped with
D = 0.01. The relevant eigenvalues (1 and 6) have angular frequencies of 𝜔1 = 7.623 rad/s and
𝜔6 = 32.620 rad/s. In the Lehr's to Rayleigh damping calculatorwhich can be accessed via the
button, the angular frequencies and the damping values are defined as seen in Figure 5.49.

After [OK], the corresponding Rayleigh coefficients 𝛼 = 1.235839E − 01 and 𝛽 = 4.9692E − 04
are set in the Damping tab (see Figure 5.48).
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Figure 5.49: Settings in Lehr's to Rayleigh damping calculator

Results in Case of Resonance
As stated earlier, the natural frequency in X-direction is very close to the excitation frequency,
which causes resonance. The results are expected to be very large. The deformation of the
structural system are illustrated in Figure 5.50. In the Time CourseMonitor, the displacements in
X-direction at Node 73 are displayed versus the time. The resonance can be clearly seen. The
maximum displacement is about u = 145.2 mm

Figure 5.50: Displacementu resulting from timehistory analysiswithdynamic envelope inworkwindowand
displacement uX at node 73 displayed versus time in Time CourseMonitor showing resonance
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Adjustment of Structural System
To avoid that kind of resonance case as seen in Figure 5.50, the cross-sections of the beams and
columns are modified as illustrated in Figure 5.51. This is done to achieve a considerable shift of
the dominant natural frequency.

Figure 5.51: Structural system with modified cross-section of beams and columns

The changed frequencies of the structure are listed in Figure 5.52. The dominant eigenvalues are
highlighted.

Figure 5.52: Eigenvalues of modified structural system showing dominant mode shape 12 in X-direction
with frequency f12 = 4.00 Hz

The dominant frequency is now about f = 4.00 Hz and, therefore, shifted by 1.2 Hz compared to
the critical frequency.

Additionnally, theRayleighdamping coefficients need tobeadjusted so that thedominant frequen-
cies are damped with D = 0.01. With the modified frequencies, the coefficients are determined
as 𝛼 = 7.82 × 10−02 and 𝛽 = 6.71 × 10−04.

The other settings are kept as before. Then the time history analysis is performed again.



5 Examples

©DLUBAL SOFTWARE 2020

112

5
As a result, the displacements are much smaller. In the Time Course Monitor, the effect of damping
can be well seen compared to the case of resonance. There the root mean square value (RMS),
which is calculated from the displacement values from t = 0 s to t = 10 s, is shown as well.

Figure 5.53: Displacement u of altered structural system with dynamic envelope in work window and
displacement uX at node 73 displayed versus time in Time Course Monitor and RMS value of
6.9 mm showing no resonance

This example demonstrates how to analyse machine-induced vibrations by RFEM and the add-on
module RF-DYNAM Pro. It shows how important it is to analyse the frequencies of the structure in
order to eliminate resonance cases.
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